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1 Safety Information

Before starting installation, setting up, operation and before 
maintenance work is carried out, it is essential to read and follow 
the appropriate warning and safety information given in this 
manual.

Installation, setting up, operation and maintenance of the mod-
ules or devices must take place as intended, i.e. under the condi-
tions of use laid down in this manual and in the technical data for 
the relevant module or device.

1.1 Intended use

The products in the Q.series range are intended for use in indus-
trial and experimental test engineering and for monitoring 
assembly and production processes. Transducers (sensors) for 
the acquisition of physical quantities such as voltage, current, 
resistance, temperature, force, displacement, torque, mass, 
strain and pressure can be connected. The modules are used 
exclusively for these kinds of measurement and control applica-
tions. Any application which goes beyond this scope does not fall 
within the intended use of the modules.

To ensure safe operation the modules and devices must only be 
operated according to the details given in the manuals and tech-
nical data sheets. In addition, the required legal and safety regu-
lations covering the respective application must be followed. This 
applies in particular to the modules A123, A124, A127 and A128 
with which input voltages of up to 1200 VDC are possible.

1.2 Checking for damage in transit

On receipt of the goods visually check that the packaging and the 
module or device together with the data medium are intact. Also 
check the shipment for completeness (accessory parts, documen-
tation, auxiliary aids, etc.). If the packaging has been damaged in 
transit or if you suspect that the product is damaged or may mal-
function, the product must not be put into operation. In this case 
contact your customer consultant or Gantner Instruments GmbH.

1.3 Personnel

The installation, operation and maintenance of the modules or 
devices must only be carried out by competent persons. Compe-
tent persons are those who through their professional education 
have sufficient knowledge in the required field and are familiar 
with the relevant national occupational protection regulations, 
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accident prevention regulations, guidelines and accepted engi-
neering rules. They must be able to reliably assess the results of 
their work and must be familiar with the contents of this manual.

Electrical connections must only be carried out by specialist per-
sonnel trained for the task.

In particular, pay attention to the following:

• the national installation and erection regulations (e.g. ÖVE, 
VDE, etc.)

• generally accepted engineering rules

• the details on transport, installation, operation, servicing, 
maintenance and disposal in this manual.

• the parameters, limits and the details about the operating and 
ambient conditions on the name-plates and in the data sheets.

1.4 Special risks

The modules A123, A124, A127 and A128 are specifically 
intended for measurements at high voltages. Consequently, on 
the modules a voltage of up to 1200 V may be present, which can 
lead to fatal or severe injury on touching the terminal contacts or 
bare parts of the connecting cables. Therefore, make sure that 
only qualified personnel have access to the modules or devices 
and that the voltages on modules can be switched off by a switch-
disconnector or similar device for service purposes.

1.5 Siting locations

The devices in the Q.series range are protected to IP 20 against 
water, dirt and small parts. If the ambient conditions require it, 
the modules can be fitted in water-protected or watertight hous-
ings.

Please note the admissible ambient temperatures specified in the 
technical data.

1.6 Modifications

Making modifications to the modules or devices is not permitted. 
Dirt and shrouding covers may only be removed for service and 
maintenance purposes.

1.7 Servicing and cleaning

The modules or devices do not need any servicing. Cleaning may 
only take place in the voltage-free state. Therefore follow the 
points below:
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• Before cleaning, disconnect all connectors.

• Clean the housing with a soft, slightly moistened cloth. Never 
use any solvents, because these may attack the labels.

• When cleaning, make sure that no liquid enters into the 
device or goes onto the terminals.

Never attempt to repair nor to again operate devices which are 
defective, have developed a fault or are damaged. In this case it 
is essential to contact your customer consultant or Gantner 
Instruments GmbH.

1.8 Disposal

Old devices which are no longer usable must be disposed of 
according to national and local regulations regarding environ-
mental protection and raw-material recycling. Electronic compo-
nents must not be disposed of with the household refuse. The 
packaging can be recycled and should therefore be passed into 
the recycling system. However, we recommend that the packag-
ing is kept until the end of the warranty period so that you can 
pack faulty devices or modules properly.

1.9 General hazards due to non-observance of the 
safety information

The modules or devices conform to the state of the art and are 
operationally safe. However residual risks may arise when they 
are used and operated improperly by untrained personnel.

Any person commissioned with the task of siting, operating, ser-
vicing or repairing a module or device in the Q.series must have 
read and understood the operating manual and in particular the 
information relating to safety.
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2 Labels and warning infor-
mation

2.1 Warning information

To prevent personal injury and damage to property it is essential 
that you follow the warning and safety information given in this 
operating manual.

Indicates a directly threatening hazard. If it is not pre-
vented, the consequence will be fatal or serious injuries.

Indicates a possibly hazardous situation. If it is not prevented, the 
consequence may be fatal or serious injuries.

Indicates a possibly hazardous situation. If it is not prevented, the 
consequence may be injuries of slight or medium severity.

Indicates a situation in which the consequence may be property 
damage if the information is not followed.

2.2 Labels on the modules

Symbol: 

Meaning: This symbol is the CE marking. This shows that we 
guarantee that our product meets the requirements of the rele-
vant EC directives.

Symbol:  CAT I, CAT II, CAT III

Meaning: Modules with this symbol are intended for the connec-
tion of high voltage. The maximum admissible voltage is also 
given.

Symbol: 

Meaning: High voltage may be present on the module connec-
tions. Connection may only be made with the insulated connect-
ing plugs provided.
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2.3 Labels in this manual

To simplify reading this manual we use – along with the warning 
information given above – the following labels and notation:

IMPORTANT
Paragraphs with this symbol give important information about 
the product or about using the product.

Tip
Contains application hints and other particularly useful informa-
tion.

Symbol: 

Meaning: Before connecting or disconnecting cables make sure 
that all sources of power are Locked Out.

italics signifies highlighted text

interface signifies entries and entry fields in program 
user interfaces

Options indicates menu items in the program user 
interfaces

> signifies a sequence of menu items, e.g. in 
Options > Settings

➡ indicates special features or restrictions
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3 Introduction
 Dear Customer,

Thank you for purchasing a product in the Q.series from Gantner 
Instruments GmbH. We are sure that you have obtained an excel-
lent product which will enable you to make fast and reliable mea-
surements with low measurement uncertainties.

The manual is included in the items supplied. Keep the manual 
safe or download the latest version from our web site. If you find 
faults on the product or errors in the accompanying documenta-
tion or if you have suggestions for improvement, please contact 
your customer consultant or Gantner Instruments GmbH directly. 
We would be glad to receive your comments and ideas.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all 
sections are open to the public).
 

Austria Gantner Instruments GmbH

Montafonerstr. 4

6780 Schruns/Austria

Tel.: +43 (0) 55 56 774 63-0
Fax: +43 (0) 55 56 774 63-300

E-mail: office@gantner-instruments.com
Web: www.gantner-instruments.com

Germany Gantner Instruments Test & Measurement GmbH

Heidelberger Landstr. 74

64297 Darmstadt

Tel.: +49 (0) 6151 95136-0
Fax: +49 (0) 6151 95136-26

E-mail: testing@gantner-instruments.com
Web: www.gantner-instruments.com



Vers. No. 2.0
12 Released: 5/07/2016

3     Introduction

3.1 The documentation of the Q.brixx family

The documentation for Q.brixx consists of this manual about the 
Q.brixx modules A101, A102, A103, A104, A105, A106, A107, 
A108, A109, A111, A116, A123, A124, A127, A128, D101, D104, 
D105, D107 and S104 as well as the Q.gate Test Controller. 
Detailed descriptions on special settings for Q.gate can be found 
in other Gantner Instruments Test & Measurement GmbH docu-
mentation on the Gantner CD or on our home page www.gantner-
instruments.com.

You will find this manual also as a PDF file on our home page and 
on the Gantner CD enclosed with your system or which you can 
order free of charge from Gantner Instruments Test & Measure-
ment GmbH.

3.2 About this manual

This manual describes the installation, initial operation and the 
configuration of the modules Q.brixx A101, A102, A103, A104, 
A105, A106, A107, A108, A109, A111, A116, A123, A124, A127, 
A128, D101, D104, D105, D107 and S104 with the Q.gate Test 
Controller using the program test.commander. The modules are 
differentiated through the number of their analog and/or digital 
inputs and outputs as well as by the maximum possible measur-
ing rate.

The manual is divided into several chapters:

• Safety information in Chapter 1, from page 5 onwards.

• A description of the labels and symbols used on the modules 
and in this documentation can be found in Chapter 2 from 
page 9 onwards.

• You will find a description of the system and the main combi-
nation and expansion options in the next section.

• The description of the connection variants and the pin assign-
ments on the inputs and outputs can be found in Chapter 4, 
Connection, from page 15 onwards.

• A comprehensive introduction to the configuration of the 
modules using the program test.commander is given in 
Chapter 5, Configuration, from page 81 onwards.

• Comprehensive explanation of the module measurement tech-
nology and background information about working proce-
dures can be found in Chapter 6, Functional Procedures, from 
page 115 onwards.
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3.3 System description

The modules in the Q.brixx series have been developed for indus-
trial and experimental measurement and test engineering, in par-
ticular for multi-channel measurements of electrical, mechanical 
and thermal signals on engine and component test-rigs as well as 
for monitoring processes and long-term supervision. The modules 
A123, A124, A127 and A128 are specially designed for measure-
ments at high voltages.

Voltages of up to 1200 V may be present on the connections 
of the modules A123, A124, A127 and A128.

Before connecting or disconnecting cables on these mod-
ules make sure that all sources of power are Locked Out.

The individual modules can be combined to form one system as 
required. You can connect up 16 modules to the Q.gate Test Con-
troller and then address them from a PC or PLC via a single inter-
face.

On all modules the power supply, bus interface and the inputs 
and outputs are electrically isolated from one another.

Operating the modules via Q.gate

The Q.gate Test Controller can be operated to the far left or far 
right next to the Q.brixx modules (first or last slot). It cannot how-
ever be installed between the modules.

Fig. 3-1 Q.gate with 8 modules.

Depending on the operating mode of the modules, transmission 
rates of 1 kHz with up to 128 variables (transferred values with 
four byte resolution, real variables) are possible over Ethernet.

max. 16 modules, here: 8 modulesQ.gate
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UART data throughput at 24 MBaud

Measuring rate 1 kHz

Measuring rate 10 kHz

Measuring rate 100 kHz

200 real variables

20 real variables

2 real variables

Ethernet data throughput (transmission rate with block transfer)
128 real variables (1 kHz)

16 real variables (10 kHz)

Ethernet data throughput (transmission rate with online transfer) 64 real variables (300 Hz)

Interfaces
Ethernet, USB, RS-232, 
2 UARTs

Max. number of slaves (Q.brixx) 16
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4 Connection

This chapter contains the description of the connection variants 
and pin assignments.

4.1 Connecting the power supply

For the power supply an unregulated direct voltage between 10 
and 30 volts is required, which is connected to the socket right at 
the bottom in the Q.gate. Fig. 4-1 shows the pin assignment. Each 
module requires a power of approx. 2 W in addition to the power 
supplied for the connected transducers. The power required is 
almost constant over the complete voltage range.

Fig. 4-1 Pin assignment on the power supply socket.

IMPORTANT
When the modules are switched on, there is an increase current 
demand until the modules are operating in a stable manner: In 
the start-up phase up to 700 mA (10 ms) per module is needed 
depending on the supply voltage. Thereafter, you should expect 
approx. 500 mA per module for a 10 V supply voltage, with a 30 V 
supply voltage approx. 170 mA. You should therefore either use 
power supplies which can deliver the required peak power when 
the voltage is switched on or – with many modules – switch the 
modules on in several groups.

The modules have an internal self-healing (reversible) fuse for 
protection against overvoltages, overcurrents and incorrect 
polarity. 

➡ Do not use cable which is too thin for the connection so that the 
required power can be transferred to the module without signifi-
cant losses. 

Power supply +
(upper pin, red spot)

Power supply –
(lower pin)



Vers. No. 2.0
16 Released: 5/07/2016

4     Connection → Connecting interfaces

4.2 Connecting interfaces

For communication (configuration and data interchange) with the 
modules you must connect the Q.gate Test Controller via Ether-
net (Section 4.2.1, page 16) to a PC or PLC. The configuration is 
carried out exclusively via the Ethernet interface.

We recommend the use of cables to Cat-5e or better.

For setting an IP address or for logging purposes you can also 
use the RS-232 interface of the Q.gate Test Controller 
(Section 4.2.2, page 17).

4.2.1 Connecting /Q.gate via Ethernet to a PC/PLC

The Q.gate Test Controller uses DHCP (Dynamic Host Configura-
tion Protocol) to obtain an address from a server in the network. 
In this case you only have to connect the Test Controller to an 
Ethernet switch. An IP address is assigned automatically.

Tip
We recommend the use of industrial Ethernet switches. Q.gate  
uses autonegotiation and operates, if available, with 100 Mbit/s 
and full duplex for the transmission.

Connection without a server If you are not connected to a network or there is no server in the 
network, you should set your PC to DHCP (Control Panel > Net-
work) and connect to the Q.gate Test Controller. Windows XP or 
Windows Vista then negotiates a suitable address so that you can 
communicate with the module and can set a fixed Ethernet 
address. Consequently, set your PC also to a fixed IP address 
from the same address range, because otherwise no link can be 
established to the module.

Tip
Refer also to Section 6.1, Ethernet on the PC, on page 115 for the 
display and setting of the PC IP address.

If the Test Controller does not receive an IP address from a 
server, then it adjusts to its static IP address after a few seconds. 
The factory setting of the static IP address of the Test Controller 
is 192.168.1.28.

Connection in a network 

with a server

In the factory setting the Test Controllers use DHCP, i.e. they 
receive a valid network address from a server which is present in 
the network. Connect the PC or the PLC to the same network. 
Then you can establish the link immediately via test.commander 
and can therefore also assign a fixed address to the Test Con-
troller. Refer also to Section 6.1 on page 115.
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Procedure Setting an Ethernet address (IP address)

1. Make sure that the current version of the test.commander 
software is installed on your PC.

You will find the current version in the download section of 
our home page. If necessary, install the current version; refer 
to Section 5.1 on page 82.

2. Start the software.

3. Using the menu Utilities > Controller network terminal  
call the dialog for finding Test Controllers.

4. Click on Configure IP settings.

5. Select Manually configure network settings and specify 
the required IP address (IP address), the subnet mask (Sub-
net mask) and – if necessary – the gateway address (Default 
gateway). If in doubt, details can be obtained from your net-
work administrator.

6. Click on Apply to accept the changes.

Example

Selected new IP address for the Test Controller: 192.168.169.85
Possible PC IP address: 192.168.169.10
Subnet masks of the PC and module: 255.255.255.0

Tip
Alternatively, you can also use the wizard for the initial operation 
in the test.commander program.

Section 6.1, Ethernet on the PC on page 115 contains further 
information about the use of Ethernet addresses and subnet 
masks.

4.2.2 Using the RS-232 interface of Q.gate

The RS-232 interface is used for the output of protocol informa-
tion and for setting the IP address if this is not possible else-
where.

The RS-232 interface of the Q.gate Test Controller is located 
below the USB interface at the front. For the link to a PC you 
require the supplied cable with the 3.5 mm stereo jack plug.
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Fig. 4-2 Pin assignment for RS-232 on the jack plug.

Procedure Setting an Ethernet address (IP address) via RS-232

1. Make sure that the current version of the test.commander 
software is installed on your PC.

You will find the current version in the download section of 
our home page. If necessary, install the current version; refer 
to Section 5.1 on page 82.

2. Start the software.

3. Using the menu Utilities > Controller serial terminal call 
the dialog for finding Test Controllers.

4. Specify the required IP address (IP address), the subnet 
mask (Subnet mask) and – if necessary – the gateway 
address (Default gateway). If in doubt, details can be 
obtained from your network administrator.

5. Click on Apply to accept the changes.

Example

Selected new IP address for the Test Controller: 192.168.169.85
Possible PC IP address: 192.168.169.10
Subnet masks of the PC and module: 255.255.255.0

Section 6.1, Ethernet on the PC on page 115 contains further 
information about the use of Ethernet addresses and subnet 
masks.

4.2.2.1 Establishing connection with the test.commander setup wizard

1. Make sure that the current version of the test.commander 
software is installed on your PC.

You will find the current version in the download section of 
our home page. If necessary, install the current version; refer 
to Section 5.1 on page 82.

2. Start the software and select the Utilities > Module setup 
assistant 

Another program window opens.

3. Select Options > Communication settings.

4. Under Interface type select the RS-232 direct connection 
and under ComPort the PC connection you are using.

TxGND, 
Ground

Rx
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5. Close the dialog with OK.

Further interface parameters are not needed.

6. Click on Find modules.

The program searches the specified interface for connected 
modules and displays all the modules found in the program 
window. If there are addressing conflicts, they are also dis-
played. Specify unique addresses for the modules; refer to 
Section 5.2 on page 83.

4.2.2.2 Establishing connection with ICP 100

1. Make sure that the current version of the ICP 100 software is 
installed on your PC.

You will find the current version in the download section of 
our home page. If necessary, install the current version; refer 
to Section 5.1 on page 82.

2. Start the software and select Communication > Parame-
ters. 

3. Under Interface type select the RS-232 direct connection 
and under ComPort the PC connection you are using.

4. Close the dialog with OK.

The program searches the specified interface for connected 
modules and displays all the modules found in the program 
window. If there are addressing conflicts, they are also dis-
played. Specify unique addresses for the modules; refer to 
Section 5.2 on page 83.

4.3 Synchronization of several systems

The synchronization of the Q.brixx modules in one housing (one 
system) is provided through the Test Controller. The Test Con-
troller ensures that all subordinate modules operate synchro-
nously with the maximum jitter being approximately ±2 μs over 
all modules.

You have various methods of obtaining synchronization, even 
with several systems (refer also to Fig. 4-3 on page 21):

1. Use the time signal in the  Test Controllers based on the IRIG 
standard (Inter Range Instrumentation Group) to synchronize 
all other Test Controllers to one master controller.

The master controller (first device in the chain of devices) 
uses its internal clock for the date/time stamp (gray path in 
Fig. 4-3). For this type of synchronization you must lay syn-
chronization lines between the Test Controllers; the maxi-
mum length of all lines together is 1000 m. The order of con-
nection is not important. The master controller transfers the 
time stamp via an RS-485 link to the other Test Controllers. 
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This method achieves the best time synchronization with the 
smallest jitter (approx. ±2 μs) between the individual mod-
ules, because the time information passes simultaneously to 
all Test Controllers.

2. You connect a radio receiver for time signals, e.g. for DCF77 
which converts the received time signal to IRIG-B, to a Test 
Controller.

As master controller this then synchronizes all other Test 
Controllers using IRIG (orange colored path in Fig. 4-3) as 
with Variant 1. If it is not possible to connect the individual 
Test Controllers via synchronization lines or this is not 
desired, you can also connect a receiver to each Test Con-
troller (Variant 2b).

3. You connect an NMEA-0183 compatible GPS receiver (Global 
Positioning System) to a  Test Controller, which then, similar 
to Variant 1, synchronizes as master controller all other Test 
Controllers.

With this method the time information of the GPS signal is 
evaluated instead of a pure time signal. In addition you can 
also process the position details of the GPS receiver in the 
system and assign the measurements (light blue path in 
Fig. 4-3). If it is not possible to connect the individual Test 
Controllers via synchronization lines or this is not desired, 
you can also connect a receiver to each Test Controller (Vari-
ant 3b).

4. You define a PC as an SNTP time server which can distribute 
the NTP time stamp to all Test Controllers (dark blue path in 
Fig. 4-3).

The absolute accuracy of the time information depends on the 
method used. If you do not want to use or cannot use any time 
synchronization lines, e.g. because the spacing of the systems is 
too large, you must expect greater deviations. In the variant 2b 
the deviations lie in the range from a few milliseconds up to about 
100 milliseconds, but this depends on various factors, e.g. how 
often the time information is received. In the variant 3b the time 
accuracy of the GPS signal is decisive, which is only approx. 1 
second absolute.

The fourth method uses, for example, the SNTP protocol (Simple 
Network Time Protocol) used in the Microsoft Windows operating 
system to transfer the date and time via Ethernet. However, the 
individual Test Controllers must always query the time server in 
order to be able to synchronize their times to the time server. The 
achievable accuracy is therefore not as good as for the three 
other methods. If required, you can also set up a (full) NTP time 
server on a PC and synchronize it with a time server in the Inter-
net. You will find further information about this at http://
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www.meinberg.de (here you can also downloaded a time server 
program) and at http://www.pool.ntp.org. The time accuracy is 
then only dependent on the response times in your network.

Fig. 4-3 Possible types of time synchronization.

If you combine several synchronization methods, the best possi-
ble one is always used from those available:

1. Hardware synchronization (synchronization of the Q.series, 
IRIG-B using a time signal, e.g. DCF77)

2. Time signal from GPS (NMEA-0183)

3. SNTP

The configuration of the synchronization in all cases occurs via 
the test.commander program, refer to Section 5.8.3.3, Synchroni-
zation, page 103. 

4.3.1 Connection of a radio receiver for time signals

A radio receiver, e.g. for DCF77, is connected through the “Sync” 
socket (Lemo plug on Q.gate). The variant is only possible when 
the receiver has an RS-485 interface, because the sync input uses 
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this interface. Contact Gantner Instruments GmbH to obtain a 
suitable connecting lead and other information.

The configuration is carried out using the program test.com-
mander and the menu Settings > Synchronization > Sync. 
settings. Protocol; refer also to Section 5.8.3.3, page 103.

4.3.2 Connection of a GPS receiver

NMEA-compatible GPS receivers normally have a serial interface 
and are therefore connected through RS-232 to the Q.gate Test 
Controller (RS-232 input at the front).

The configuration is carried out using the program test.com-
mander and the menu Settings > Synchronization > Sync. 
settings. Protocol; refer also to Section 5.8.3.3, page 103.

4.4 Module flashing frequency

The modules have three LEDs: one blue LED on the upper edge 
(A) and one red LED per connector strip (B and C). In normal 
operation the blue LED lights, but the red LEDs do not light. 
Depending on the error, the LED of the affected connector strip 
or the blue LED lights or all LEDs flash in a certain order. In the 
following illustrations a short dash corresponds to short flash and 
a long dash to a long flash.

4.4.1 SOS

Fig. 4-4 Flashing sequence with an incorrect module or when 
there are no settings in the base.

Cause: The configuration saved in the base does not match that in 
the module.

There may be two reasons for this:

1. There is no configuration in the base yet.

2. The module type saved in the base configuration differs from 
the plugged-in module, therefore the configuration cannot be 
accepted.

Consequently, either change the module for the correct module 
type or reconfigure the module (Chapter 5, Configuration, 
page 81). The (new) configuration is then automatically saved in 
the base.

blue LED
red LED B
red LED C



Q.series
Gantner Instruments GmbH 23

4     Connection → Module flashing frequency

4.4.2 Firmware download

Fig. 4-5 Flashing sequence on downloading the module firmware.

The LEDs flash as long as the download runs.

4.4.3 FPGA download

Fig. 4-6 Flashing sequence on downloading the FPGA firmware.

The LEDs flash as long as the download runs.

4.4.4 Problems during data transmission

Fig. 4-7 Flashing sequence for problems during the data transmis-
sion.

These flashing sequences indicate a problem with the communi-
cation.

Restart the system (by switching off, waiting one minute and then 
switching on again). If these measures do not rectify the error, a 
hardware fault is probably present. Contact your customer con-
sultant or Gantner Instruments GmbH directly.

4.4.5 LED displays in normal operation

For modules with analog inputs a red illuminated LED indicates 
that the measurement range has been exceeded on at least one 
input. You can suppress this indication in the module configura-
tion.

For modules with digital inputs or outputs an orange illuminated 
LED indicates that an input or output is active.

blue LED
red LED B
red LED C

blue LED
red LED B
red LED C

or
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4.5 The modules and their connection options

1) Half bridge only with Q.brixx Terminal
2) Quarter bridge with Q.brixx Terminal

Modules: A 
101

A 
102

A 
103

A 
104

A 
105

A 
106

A 
107

A 
108

A 
109

A 
111

A 
116

Signal inputs

Voltage X X X X X X X

Current X X X X X

Potentiometer X X

Resistance X X X

Pt100, Pt1000 X X X

Thermocouple X X X

(Strain gauges) full + half 
bridge

X X X X1) X

Strain-gauge quarter bridge X2) X2) X2) X2) X

Inductive full and half bridge X

LVDT, RVDT X

IEPE/ICP® Sensor X X X

Digital input: frequency, 
pulse width, counter

X

Digital input: Status X X X X X X

Signal outputs

Voltage X X X

Current X X

Digital output: 
frequency, pulse width

X

Digital output: Status X X X X X X

Number of channels 2 1 8 8 4 2 4 8 4 4 8

Data rate (in Hz) 100 k 100 k 100 100 10 10 k 10 k 10 k 100 k 100 k 10 k

For description refer to page 26 31 35 37 40 42 46 52 54 56 58
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Modules: A123 A124 A127 A128 D101 D104 D105 D107 S104

Signal inputs

Voltage X X X X

Current

Potentiometer

Resistance

Pt100, Pt1000

Thermocouple X

(Strain gauges) full + half 
bridge

Strain-gauge quarter bridge 

Inductive full and half bridge

LVDT, RVDT

IEPE/ICP® Sensor

Digital input: frequency, 
pulse width, counter

X X

Digital input: Status X X X

Signal outputs

Voltage

Current

Digital output: 
frequency, pulse width

X

Digital output: Status X X

Number of channels 4 4 4 4 8 16 16 6

Data rate (in Hz) 100 k 10 k 100 k 100 k
up to 
100 k

10 k 10 k 1 M

For description refer to page 62 64 66 68 70 73 74 75 78



Vers. No. 2.0
26 Released: 5/07/2016

4     Connection → Q.brixx A101: Connecting sensors and I/O

4.6 Q.brixx A101: Connecting sensors and I/O

The Q.brixx Module A101 has two electrically isolated analog 
inputs and two digital inputs or outputs. The pin assignment of 
the two connector strips is identical and the connection terminals 
have numbers for identifying the connections.

GND identifies the measurement ground of an input, 0 V and +V 
refer to the (external) supply voltage connections. Measurement 
ground and (module) supply voltage are electrically isolated in 
the module.

Fig. 4-8 Pin assignment for Q.brixx Module A101.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

 4.6.1 Voltage

With voltage measurements two connection variants are possible, 
depending on the level of the voltages to be measured: up to 10 V 
and up to 60 V.

4

(5)

2 (+)
3

7 (GND)
6

U

up to 10 V

up to 60 V

3 (+)

7 (GND)

U
1 (+)

7 (GND)

I

3 (+)

7 (GND)

2

3

4

2

3
4 (–)

3 (+)

120Ω 350Ω

6

4
1

6

4
1

IEPE
7 (GND)

8 (+)

Din Dout
10

+V

0V

10

2

5
3

4

1 60 V
2 UF
3 AIn 1
4 AIn 2
5 AIn 3
6 AIn 4
7 GND
8 IEPE
9 TEDS
10 DIO

1 60 V
2 UF
3 AIn 1
4 AIn 2
5 AIn 3
6 AIn 4
7 GND
8 IEPE
9 TEDS
10 DIO

requires Q.bloxx 
Terminal CJC

1
0

1
1
0

1
P

lu
g
 1

P
lu

g
 2



Q.series
Gantner Instruments GmbH 27

4     Connection → Q.brixx A101: Connecting sensors and I/O

IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-9 A101, measurement of voltage.

4.6.2 Current

A shunt resistance of 50  is integrated into the Q.brixx Module 
A101 for current measurement. This facilitates the measurement 
of currents of up to 25 mA. For higher currents use a voltage mea-
surement and an external shunt; refer to Section 6.4, page 124.

Fig. 4-10 A101, measurement of current.

4.6.3 Potentiometer

Potentiometers with resistances between 1 k and 10 k are con-
nected in a three-wire configuration.

Fig. 4-11 A101, measurement with potentiometers.

4.6.4 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire 
or four-wire circuits. You specify the selected type of circuit 
during the module configuration (Type column).

Voltages up to 10 V Voltages up to 60 V

U
3 (+)

7 (GND)
U

1 (+)

7 (GND)

I

3 (+)

7 (GND)

2

3

4
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Fig. 4-12 A101, measurement of resistance and Pt100/1000 probes.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 120.

4.6.5 Thermocouple

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold point 
compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A101 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.5, Measuring with thermocouples, page 125.

Fig. 4-13 A101, measurement with thermocouple using Q.bloxx 
Terminal CJC-A101.

4.6.6 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 

2-wire circuit 4-wire circuit

2

3

2

5
3

4

4 (–)

3 (+)

Q
.b

lo
xx

 T
e
rm

in
a
l 

C
JC CJC–

CJC+
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bridges the side drawn in dashes and the connection 5 are omit-
ted.

The bridge excitation voltage is 2.5 V. 

Fig. 4-14 A101, measurement with full and half bridges.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 120.

4.6.7 Strain-gauge quarter bridges

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A101 with120  or B4/350-A101 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage is 2.5 V.

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the Q.bloxx Terminal, you have to select a 
full bridge circuit as the bridge type for the channel.

Fig. 4-15 A101, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4.

4.6.8 IEPE/ICP® sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

4

(5)

2 (+)
3

7 (GND)
6

120Ω 350Ω

6

4
1

6

4
1
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Fig. 4-16 A101, measurement with IEPE or ICP® sensors.

4.6.9 Digital input and output

On each connecting plug a contact is available for an input or out-
put. You can use the appropriate function depending on the wir-
ing.

Fig. 4-17 A101, digital input and output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.

IEPE
7 (GND)

8 (+)

Input Output

Din Dout
10

+V

0V

10
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4.7 Q.brixx A102: Connecting sensors and I/O

The Q.brixx Module A102 has one electrically isolated analog 
input, one analog output and two digital inputs or outputs electri-
cally isolated from the analog section. The assignment of both 
connector strips is not identical. The plug number is specified in 
the following. The connection terminals have numbers for identi-
fying the connections.

GND identifies the measurement ground of an input, 0 V and +V 
refer to the (external) supply voltage connections. Measurement 
ground and (module) supply voltage are electrically isolated in 
the module.

Fig. 4-18 Pin assignment for Q.brixx Module A102.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

 4.7.1 Voltage

You can measure voltages of up to 10 V via Plug 2.

Plug 1, outputs

Plug 1, inputs

Plug 2, inputs

U
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7 (GND)

I
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8 DO 2
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2 USen+

3 USig+

4 USig–

5 USen–

6 UExc–

7 GND
8 UIn

9 IIn
10 TEDS

1
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-19 A102, measurement of voltage, Plug 2.

4.7.2 Current

A shunt resistance of 50  is integrated into the Q.brixx Module 
A102 for current measurement. This facilitates the measurement 
of currents of up to 25 mA via Plug 2. For higher currents use a 
voltage measurement and an external shunt; refer to Section 6.4, 
page 124.

Fig. 4-20 A102, measurement of current, Plug 2.

4.7.3 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 
bridges the side drawn in dashes and the connection 4 are omit-
ted.

The bridge excitation voltage is switched via software between 
1 V, 2.5 V, 5 V and 10 V. 

Fig. 4-21 A102, measurement with full and half bridges, Plug 2.

U
8 (+)

7 (GND)

I

9 (+)

7 (GND)

3

(4)

1 (+)
2

5
6 (–)
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Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 120.

4.7.4 Strain-gauge quarter bridges

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A102 with120  or B4/350-A102 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage is switched via software between 
1 V, 2.5 V, 5 V and 10 V. 

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the , you have to select a full bridge circuit 
as the bridge type for the channel.

Fig. 4-22 A102, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4 on Plug 2.

4.7.5 IEPE/ICP® sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

Fig. 4-23 A102, measurement with IEPE and ICP® sensors, Plug 2.

4.7.6 Analog output

An analog output for voltage or current is available on Plug 1. The 
selection between voltage and current is made via software.

120Ω 350Ω

6

4
1

6

4
1

IEPE
7 (GND)

8 (+)
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Fig. 4-24 A102, output of voltage or current, Plug 1.

4.7.7 Digital input and output

Contacts for four inputs and two outputs are available on Plug 1.

Fig. 4-25 A102, digital input and output, Plug 1.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.

U
1 (+)

2 (–)
I

1 (+)

2 (–)

Input Output

Din Dout
3, 4, 5, 6

+V

0V

7, 8
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4.8 Q.brixx A103: Connecting sensors and I/O

The Q.brixx Module A103 has eight electrically isolated analog 
inputs and two digital inputs and outputs. The pin assignment of 
the two connector strips is identical and the connection terminals 
have numbers for identifying the connections. You will find the 
associated figures in each case at the same place in the circuit 
diagrams, for example each of the figures quoted in the second 
place belong to one possible connection method.

The designations 0 V and +V refer to the (external) supply voltage 
connections. Measurement ground (–) and the (module) supply 
voltage are electrically isolated in the module.

Fig. 4-26 Pin assignment for Q.brixx Module A103.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

 4.8.1 Voltage

You can measure voltages of up to ±10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-27 A103, measurement of voltage.

4.8.2 Current

For current measurement you need the connecting plug Q.brixx 
Terminal SR containing the shunt resistances. This facilitates the 
measurement of currents of up to 25 mA.

Fig. 4-28 A103, measurement of current via Q.brixx Terminal SR.

4.8.3 Digital input and output

On each connecting plug two contacts are available for an input 
and an output.

Fig. 4-29 A103, Digital Input and Output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.
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4.9 Q.brixx A104: Connecting sensors

The Q.brixx Module A104 has eight electrically isolated analog 
inputs for thermocouples or voltages. The pin assignment of the 
two connector strips is identical and the connection terminals 
have numbers for identifying the connections. You will find the 
associated figures in each case at the same place in the circuit 
diagrams, for example each of the figures quoted in the second 
place belong to one possible connection method.

The module can also be obtained with other connections, e.g. 
with Mini TKC sockets. In this variant no Q.bloxx Terminal CJC-
A104 is needed.

Tip
To secure the thermocouple plug-in connector against falling out, 
perforated metal nipples are fitted over the sockets in the version 
with TKC sockets. After inserting all thermocouple plug-in con-
nectors, insert, for example, a wire through the holes in the plugs 
and the metal nipples and twist the ends of the wire.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Fig. 4-30 Pin assignment for Q.brixx Module A104 (left), version 
with Mini TKC sockets on the right side.
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Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

 4.9.1 Voltage

You can measure voltages of up to 80 mV.

IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-31 A104, voltage measurement.

4.9.2 Thermocouple

For connecting thermocouples you need a special connecting 
plug for the terminal version which contains the comparative 
measuring point (cold junction compensation) required for ther-
mocouples. The plug can be obtained under the designation 
Q.bloxx Terminal CJC-A104 from Gantner Instruments GmbH. 
The plug is not needed in the version with the Mini TKC sockets. 
You can connect the following types of thermocouple: B, E, J, K, 
L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.5, Measuring with thermocouples, page 125.

U
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4, 6, 8, 10 (–)
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Fig. 4-32 A104, measurement with thermocouple using Q.bloxx 
Terminal CJC-A104.
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4.10 Q.brixx A105: Connecting sensors

The Q.brixx Module A 105 has four electrically isolated analog 
inputs. The pin assignment of the two connector strips is identical 
and the connection terminals have numbers for identifying the 
connections. You will find the associated figures in each case at 
the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method.

GND identifies the measurement ground of an input; measure-
ment ground and the (module) supply voltage are electrically iso-
lated in the module.

Fig. 4-33 Pin assignment for Q.brixx Module A105.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

4.10.1 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire, 
three-wire or four-wire circuits. However, you must in each case 
connect all the terminals, i.e. you specify the circuit used for the 
type of circuit when configuring the module (Type column), but 
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with two and three-wire circuits the unused terminals must be 
bridged.

Fig. 4-34 A105, measurement of resistance and Pt100/1000 probes.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 120.
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4.11 Q.brixx A106: Connecting sensors and I/O

The Q.brixx Module A106 has two electrically isolated analog 
inputs, two analog outputs and four digital inputs and outputs. 
The pin assignment of the two connector strips is identical and 
the connection terminals have numbers for identifying the con-
nections.

GND identifies the analog and the measurement ground, 0 V and 
+V refer to the (external) supply voltage connections. Measure-
ment ground/GND and (module) supply voltage are electrically 
isolated in the module. The measurement ground for input and 
the analog ground (output) are identical.

Fig. 4-35 Pin assignment for Q.brixx Module A106.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

 4.11.1 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) all connec-
tions are occupied. If the sensor has no sensing leads, you specify 
this during the module configuration (Type column). With half 
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bridges the side drawn in broken lines and the connection 10 are 
omitted.

The bridge excitation voltage can be 2.5 V or 5 V (DC or CF).

Fig. 4-36 A106, measurement with full and half bridges.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 120.

4.11.2 Strain-gauge quarter bridge

For the connection of strain-gauge quarter bridges you need a 
special connecting plug which contains the completion resis-
tances. The plug can be obtained under the designation Q.bloxx 
Terminal B4/120-A106 with120  or B4/350-A106 with 350  from 
Gantner Instruments GmbH.

The bridge excitation voltage can be 2.5 V or 5 V (DC or CF).

IMPORTANT
The plug must have the same resistance values as the strain 
gauges used, because otherwise no measurement is possible.
Select a half-bridge circuit as the type of bridge for the channel.

Fig. 4-37 A106, measurement with strain-gauge quarter bridge 
using Q.bloxx Terminal B4.

4.11.3 Inductive full and half bridges

With inductive full bridges all connections are occupied. If the 
sensor has no sensing leads, you specify this during the module 
configuration (Type column). With half bridges the side drawn in 
broken lines and the connection 10 are omitted.
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The bridge excitation voltage can be 2.5 V or 5 V.

IMPORTANT
During the configuration set CF 4800 Hz (carrier frequency) in 
the Type column; inductive sensors cannot be operated with 
direct voltage (DC) or 600 Hz carrier frequency.

Fig. 4-38 A106, measurement with inductive full and half bridges.

4.11.4 LVDT, RVDT

With (inductive) LVDTs or RVDTs all connections can be occu-
pied, but you can also connect without sense leads and state this 
in the Type column when configuring the module.

The bridge excitation voltage can be 2.5 V or 5 V.

IMPORTANT
During the configuration set CF 4800 Hz (carrier frequency) in 
the Type column; inductive sensors cannot be operated with 
direct voltage (DC) or 600 Hz carrier frequency.

Fig. 4-39 A106, measurement with LVDTs and RVDTs.

4.11.5 Analog output

An analog voltage output is available on each connecting plug.
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Fig. 4-40 A106, analog output.

4.11.6 Digital input and output

On each connecting plug two contacts are available for an input 
or output. You can use the appropriate function depending on the 
wiring.

Fig. 4-41 A106, Digital Input and Output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.

U
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Input Output

Din Dout
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4.12 Q.brixx A107: Connecting sensors

The Q.brixx Module A 107 has four electrically isolated analog 
inputs. The pin assignment of the two connector strips is identical 
and the connection terminals have numbers for identifying the 
connections. You will find the associated figures in each case at 
the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method.

GND identifies the measurement ground. The four inputs (UF to 
GND) are electrically isolated in the module one to the other and 
to the (module) supply voltage.

Fig. 4-42 Pin assignment for Q.brixx Module A107 (terminal ver-
sion).

The module can also be obtained in a connection variant with 
four 9-pole D-sub sockets (A107 DB9, refer to Fig. 4-43). With this 
version the module power supply (+V and 0 V) is available on the 
D-sub sockets. GND identifies the measurement ground. The four 
inputs are electrically isolated in the module one to the other and 
to the (module) supply voltage.
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Fig. 4-43 Pin assignment for Q.brixx Module A107, version with D-
sub sockets.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

4.12.1 Voltage

You can measure voltages of up to 10 V.

IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-44 A107, measurement of voltage: left: terminal version; 
right: D-sub sockets.
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4.12.2 Current

A shunt resistance of 50  is integrated into the Q.brixx Module 
A107 for current measurement. This facilitates the measurement 
of currents of up to 25 mA. For higher currents use a voltage mea-
surement and an external shunt; refer to Section 6.4, page 124.

Fig. 4-45 A107, measurement of current; left: terminal version; 
right: D-sub sockets.

4.12.3 Potentiometer

Potentiometers with resistances between 1 kOhm and 10 kOhm 
are connected in a three-wire configuration.

Fig. 4-46 A107, measurement with potentiometers; left: terminal 
version; right: D-sub sockets.

4.12.4 Resistance, Pt100, Pt1000

You can connect resistances and Pt100/1000 probes in two-wire 
or four-wire circuits. You specify the selected type of circuit 
during the module configuration (Type column).

Fig. 4-47 A107, measurement of resistance and Pt100/1000 probes; 
left: terminal version; right: D-sub sockets.
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Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 120.

4.12.5 Thermocouple (only with terminal version)

For connecting thermocouples you need a special connecting 
plug which contains the comparative measuring point (cold junc-
tion compensation) required for thermocouples. The plug can be 
obtained under the designation Q.bloxx Terminal CJC-A107 from 
Gantner Instruments GmbH. You can connect the following types 
of thermocouple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.5, Measuring with thermocouples, page 125.

Fig. 4-48 A107, measurement with thermocouple using Q.bloxx 
Terminal CJC-A107.

4.12.6 Full-bridge transducer

With (resistive) full bridges (strain-gauge full bridges) four con-
nections are occupied. If the sensor has sense leads, you should 
connect them to the relevant supply lines: in the terminal version 
to terminals 1 and 5 or 6 and 10, with D-sub sockets to pins 1 and 
8.

The bridge excitation voltage is 2.5 V. 
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Fig. 4-49 A107, measurement with full bridge; left: terminal ver-
sion; right: D-sub sockets.

4.12.7 Strain-gauge half and quarter bridges

For the connection of strain-gauge half or quarter bridges you 
need a special connecting plug which contains the completion 
resistances. The plug for the terminal version can be obtained 
under the designation Q.bloxx Terminal B4/120-A107 with120  
or B4/350-A107 with 350  from Gantner Instruments GmbH. An 
adapter plug is available for the version with D-sub sockets (Fig. 
4-50).

Fig. 4-50 Adapter plug for D-sub version.

The bridge excitation voltage is 2.5 V.

IMPORTANT
For strain-gauge quarter bridges the plug or the terminal must 
have the same resistance values as the strain gauges used, 
because otherwise no measurement is possible.
Since, for reasons of stability, all necessary completion resis-
tances are located in the Q.bloxx terminal, you always have to 
select a full bridge circuit as the bridge type for the channel.
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Fig. 4-51 A107, measurement with strain-gauge half bridge and 
quarter bridge using Q.bloxx Terminal B4 (terminal ver-
sion).

Fig. 4-52 A107, measurement with strain-gauge half bridge and 
quarter bridge through adapter plug on the version with 
D-sub sockets.
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4.13 Q.brixx A108: Connecting sensors and I/O

The Q.brixx Module A108 has eight electrically isolated analog 
inputs and two digital inputs and outputs. The pin assignment of 
the two connector strips is identical and the connection terminals 
have numbers for identifying the connections. You will find the 
associated figures in each case at the same place in the circuit 
diagrams, for example each of the figures quoted in the second 
place belong to one possible connection method.

The module is also available in the connection variant with eight 
BNC sockets (A108 BNC).

The designations 0 V and +V refer to the (external) supply volt-
age connections. Measurement ground (–) and the (module) sup-
ply voltage are electrically isolated in the module.

Fig. 4-53 Pin assignment for Q.brixx Module A108 (left), version 
with BNC sockets on the right side.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

 4.13.1 Voltage

You can measure voltages of up to 10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-54 A108, voltage measurement (terminal version); in the ver-
sion with BNC sockets the (inner) pin contact has to be 
connected to +. The outer conductor is connected to –.

4.13.2 Current

For current measurement you need the Q.bloxx Terminal SR con-
necting plug containing the shunt resistances for the terminal 
version. This facilitates the measurement of currents of up to 
25 mA. In the version with BNC sockets you must use a suitable 
shunt resistance and determine the current from the voltage drop 
and the resistance value of the shunt. The connection is made as 
for the voltage measurement.

Fig. 4-55 A108, current measurement using the Q.bloxx Terminal 
SR.

4.13.3 Digital input and output

On each connecting plug of the terminal version two contacts are 
available in each case for one input and one output.

Fig. 4-56 A108, digital input and output.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold of 10 V.
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4.14 Q.brixx A109: Connecting I/O and outputs

The Q.brixx Module A109 has four electrically isolated analog 
outputs, four digital inputs and four digital outputs. The assign-
ment of both connector strips is not identical. The plug number is 
specified in the following. The connection terminals have num-
bers for identifying the connections. You will find the associated 
figures in each case at the same place in the circuit diagrams, for 
example each of the figures quoted in the second place belong to 
one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections, NC indicates “not assigned”. Analog ground (–) 
and the (external) supply voltage (0 V) are electrically isolated in 
the module.

Fig. 4-57 Pin assignment for Q.brixx Module A109.

 4.14.1 Digital input and output, Plug 1

On Plug 1 contacts for four inputs and four outputs are available. 
Since the inputs and outputs of this module are electrically iso-
lated from the supply voltage, you must also connect 0 V for the 
inputs and 0 V and a supply voltage (+V) for the outputs.
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Fig. 4-58 A109, digital input and output, Plug 1.

The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.

Possible combinations of contact assignments for the inputs are 
shown in the following table; refer also to the block diagrams for 
Module D101.

1) e.g. counter with additional input for counting direction 
or 2-phase counter signals or frequency measurement 
with direction detection (torque transducers)

2) e.g. counter with additional inputs for counting direction, 
zero reference and reset/enable for zero reference

4.14.2 Analog output, Plug 2

The analog outputs on Plug 2 supply voltage or current. Selection 
is made via software.

Fig. 4-59 A109, output of voltage or current, Plug 2.
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4.15 Q.brixx A111: Connecting sensors and I/O

The Q.brixx Module A 111 has four electrically isolated analog 
inputs. The pin assignment of the two connector strips is identical 
and the connection terminals have numbers for identifying the 
connections. You will find the associated figures in each case at 
the same place in the circuit diagrams, for example each of the 
figures quoted in the second place belong to one possible connec-
tion method. NC signifies “No Connection”.

Measurement ground and (module) supply voltage are electri-
cally isolated in the module.

Fig. 4-60 Pin assignment for Q.brixx Module A111.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

 4.15.1 Voltage

You can measure voltages of up to 10 V.
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IMPORTANT
Voltages which exceed the admissible limits produce incorrect 
measurement data, because the inputs are protected against 
overvoltages and limit the input voltage.

Fig. 4-61 A111, measurement of voltage.

4.15.2 IEPE/ICP® Sensor

The sensor is supplied with 4 mA of current from the module (cur-
rent supply).

Fig. 4-62 A111, measurement with IEPE or ICP® sensors.
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4.16 Q.brixx A116: Connecting sensors

The Q.brixx Module A116 has eight analog inputs.

The channels (measurement ground) are electrically isolated 
against the (module) supply voltage and the interface.

Fig. 4-63 Pin assignment for Q.brixx Module A116.

4.16.1 Full and half-bridge transducers

With (resistive) full bridges (strain-gauge full bridges) six connec-
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umn); the USen inputs then remain open. With half bridges the 

side drawn in dashes and the USig- connection are omitted.

The bridge excitation voltage is 2 VDC; with 350  sensor resis-

tance you can also use 4 VDC. The internal shunt resistance can 

be activated also with full and half bridges.
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Fig. 4-64 A116, measurement with full and half bridges; USIG = sig-

nal voltage (output signal), USEN = sense lead, UEXC = 

excitation voltage

For the activation of the shunt resistance refer to Section 4.16.3.

Tip
Information about the types of circuit and the respective advan-
tages and disadvantages can be found in Section 6.2, Connecting 
sensors with sensing leads, page 120.

4.16.2 Strain-gauge quarter bridge

With this module, for the connection of strain-gauge quarter 
bridges you do not need any special connection plugs as the 120  
and 350  completion resistances are present in the module and 
only need to be activated. In addition you can activate the inter-
nal shunt resistance for test purposes.

The bridge excitation voltage is 2 VDC; with 350  sensor resis-

tance you can also use 4 VDC.

Fig. 4-65 A116, measurement with a strain-gauge quarter bridge, 
direct connection.

For the activation of the shunt resistance refer to Section 4.16.3.

With the three-wire circuit the internal completion resistance is 
used in this module to determine the voltage drop over the cable 
and to correct the result accordingly. In this way not only can the 
influence of the temperature on the cable (normal three-wire cir-
cuit) be compensated, but also the loss of sensitivity due to the 
cable resistance over a wide range.
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4.16.3 Activating the shunt resistance

You can activate the shunt both via a variable and manually via a 
button.

Open the module settings dialog(Fig. 4-66), activate the tab Vari-
able definition and click in the column Format/balance. The 
dialog of Fig. 4-67 opens.

Fig. 4-66 Module configuration dialog.

Fig. 4-67 Dialog for format settings.

Fig. 4-68 Dialog for shunt activation.

Manual activation

Define the Direction for the variable on Input/output (Fig. 4-
67) and click on Shunt cal. Activate Control computer in the 
dialog (Fig. 4-68).

Setting a value of 16 for the variable (the channel) activates the 
shunt and 0 deactivates it again.
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Activation via variable

Click on Shunt cal. Activate At variable value in the dialog 
(Fig. 4-68) and specify the variable to be used.

Any variable value > 0.5 activates the shunt.
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4.17 Q.brixx A123: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.brixx module A123 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs.

With this module the connection is provided through four BNC 
sockets. The outer side of the BNC sockets is isolated and the 
electrical connection is made through the inner side of the 
socket.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Fig. 4-69 Pin assignment for Q.brixx Module A123.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

U
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I Rext.
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AIn 2+

AIn 2–

AIn 3+

AIn 3–

AIn 4+

AIn 4–
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 4.17.1 Voltage

You can measure voltage differences of up to ±10 V. The voltage 
level (the potential) may be up to 1200 VDC.

IMPORTANT
Voltage differences which exceed the admissible limits produce 
incorrect measurement data, because the inputs are protected 
against overvoltages and limit the input voltage.

Fig. 4-70 A123, voltage measurement.

4.17.2 Current

You need an (external) shunt resistance for the current measure-
ment.

Fig. 4-71 A123, current measurement using an external shunt 
resistance. 

U
AIn +

AIn –

I Rext.

AIn+

AIn–
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4.18 Q.brixx A124: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.brixx module A124 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs for thermocouples. The terminal assignment 
is identical and the connection terminals have numbers for iden-
tifying the connections. 

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module. The plugs for the A124 module 
are 2-way plugs with push-in spring technology, i.e. you can 
insert a solid wire or a fine-stranded wire with a wire-end sleeve 

directly without screwing (max. 1.5 mm2). The plugs are perma-
nently joined to the housing and cannot be removed. With a 
screwdriver press on the white opener to be able to remove the 
connection -

Fig. 4-72 Pin assignment for Q.brixx Module A104.
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Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.

 4.18.1 Voltage

You can measure voltage differences of up to ±80 mV. The volt-
age level (the potential) may be up to 1200 VDC.

IMPORTANT
Voltage differences which exceed the admissible limits produce 
incorrect measurement data, because the inputs are protected 
against overvoltages and limit the input voltage.

Fig. 4-73 A124, voltage measurement. 

4.18.2 Thermocouple

Thermocouples can be connected directly; the comparative mea-
suring point (cold junction compensation) is integrated in the 
module plug. You can connect the following types of thermocou-
ple: B, E, J, K, L, N, R, S, T and U.

Alternatively, you can also use two thermocouples or a reference 
temperature source.

Tip
You will find information on the comparative measuring point and 
on the measurement with a reference temperature source in 
Section 6.5, Measuring with thermocouples, page 125.

Fig. 4-74 A124, measurement with a thermocouple. 

U
AIn+
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AIn –

AIn +
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4.19 Q.brixx A127: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.brixx module A127 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs. 

With this module the connection is provided through four BNC 
sockets. The outer side of the BNC sockets is isolated and the 
electrical connection is made through the inner side of the 
socket.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Fig. 4-75 Pin assignment for Q.brixx Module A127.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.
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 4.19.1 Voltage

You can measure voltage differences of up to ±1200 V. Here, var-
ious input voltage ranges from ±40 VDC to ±1200 VDC are possi-

ble. The voltage level (the potential) may be up to 1200 VDC.

Voltages above 1200 V can damage the module.

Each module is tested with a test voltage of 5 kVDC for one min-

ute. A longer duration or a higher voltage can damage the mod-
ule. In addition, each period of overvoltage reduces the service 
life of the module.

Fig. 4-76 A127, measurement of voltage.

IMPORTANT
Voltages which exceed the admissible limits give incorrect mea-
surement data, because the input voltage is internally limited.

4.19.2 Current

Confusing the current and voltage inputs can damage the module 
and/or the external load resistance.

Make sure that no high voltages are applied to the current inputs. 
The voltage drop must not be beyond ±2.4 V.

You need an (external) shunt resistance for the current measure-
ment.

Fig. 4-77 A127, current measurement using an external shunt 
resistance. 
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4.20 Q.brixx A128: Connecting sensors

The cables to be connected or disconnected may carry volt-
ages of up to 1200 V!

Before connecting or disconnecting cables make sure that 
all sources of power are Locked Out.

The Q.brixx module A128 can be used in the categories CAT II up 
to 1000 V and CAT III up to 600 V and has four electrically iso-
lated analog inputs.

With this module the connection is provided through four BNC 
sockets. The outer side of the BNC sockets is isolated and the 
electrical connection is made through the inner side of the 
socket.

Measurement ground (–) and the (module) supply voltage are 
electrically isolated in the module.

Fig. 4-78 Pin assignment for Q.brixx Module A128.

Tip
Further information on transducers and sensors can also be 
found in Chapter 6 ff. page 115.
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 4.20.1 Voltage

You can measure voltages of up to ±1200 VDC. Here, various 

input voltage ranges from ±40 VDC to ±1200 VDC are possible.

Voltages above 1200 V can damage the module.

Each module is tested with a test voltage of 5 kVDC for one min-

ute. A longer duration or a higher voltage can damage the mod-
ule. In addition, each period of overvoltage reduces the service 
life of the module.

Fig. 4-79 A128, voltage measurement.

IMPORTANT
Voltages which exceed the admissible limits give incorrect mea-
surement data, because the input voltage is internally limited.

U
AIn +

AIn –
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4.21 Q.brixx D101: Connecting I/O

The Q.brixx Module D101 has eight digital inputs and eight digi-
tal outputs. The pin assignment of the two connector strips is 
identical and the connection terminals have numbers for identify-
ing the connections.

The designations 0 V and +V refer to the (external) supply volt-
age connections.

Fig. 4-80 Pin assignment for Q.brixx Module D101.

 4.21.1 Digital input and output

On each connecting plug contacts for four inputs and four out-
puts are available. Since the inputs and outputs of this module 
are electrically isolated from the supply voltage, you must also 
connect 0V for the inputs and 0 V and a supply voltage (+V) for 
the outputs.

Fig. 4-81 D101, digital input and output.
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The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.

The following table shows possible combinations of contact 
assignments for the inputs:

1) e.g. counter with additional input for counting direction or 2-phase counter signals or fre-
quency measurement with direction detection (torque transducers)

2) e.g. counter with additional inputs for counting direction, zero reference and reset/enable 
for zero reference

3) e.g. sensors with binary coding

The following block diagrams give you an overview of the possi-
ble circuits.

Measurement of status, time, frequency or PWM 
(Pulse-Width Modulation), 1 signal

 Plug.Contact

 1.6 1.7 1.8 1.9 2.6 2.7 2.8 2.9

Status Status Status Status Status Status Status Status

Status Status Status Status Status Status 2-channel signal1)

Status Status Status Status 2-channel signal1) 2-channel signal1)

Status Status Status Status 4-channel signal2)

Status Status 2-channel signal1) 2-channel signal1) 2-channel signal1)

Status Status 2-channel signal1) 4-channel signal2)

2-channel signal1) 2-channel signal1) 4-channel signal2)

2-channel signal1) 2-channel signal1) 2-channel signal1) 2-channel signal1)

4-channel signal2) 4-channel signal2)

8-channel signal3)

Din
0V
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Up/down counter or measurement of frequency and direction with 

static direction signal, 2 signals

Measurement of frequency and direction or up/down counter with 

2-channel frequency signal (90° phase delay)

Measurement of frequency and direction or up/down counter with 

4-channel frequency signal

Din

+/-

0V

Din

0V

Din

Index

Index 
enable

0V
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4.22 Q.brixx D104: connecting digital inputs

The Q.brixx Module D104 has sixteen digital inputs. The pin 
assignment of the two connector strips is identical and the con-
nection terminals have numbers for identifying the connections. 
You will find the associated figures in each case at the same place 
in the circuit diagrams, for example each of the figures quoted in 
the second place belong to one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections, NC indicates “not assigned”.

Fig. 4-82 Pin assignment for Q.brixx Module D104.

 4.22.1 Digital input

On each connecting plug contacts for eight inputs are available. 
Since the inputs of this module are electrically isolated from the 
power supply, you must also connect 0 V and a supply voltage 
(+V).

Fig. 4-83 D104, digital input.

The digital input is active (high level) when the applied signal 
voltage lies above the (programmable) threshold.
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4.23 Q.brixx D105: connecting digital outputs

The Q.brixx Module D105 has sixteen digital outputs. The pin 
assignment of the two connector strips is identical and the con-
nection terminals have numbers for identifying the connections. 
You will find the associated figures in each case at the same place 
in the circuit diagrams, for example each of the figures quoted in 
the second place belong to one possible connection method.

The designations 0 V and +V refer to the (external) supply volt-
age connections.

Fig. 4-84 Pin assignment for Q.brixx Module D105.

 4.23.1 Digital output

On each connecting plug contacts for eight outputs are available. 
Since the outputs of this module are electrically isolated from the 
power supply, you must also connect 0 V and a supply voltage 
(+V) for the outputs.

Fig. 4-85 D105, digital output.
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4.24 Q.brixx D107: Connecting digital inputs

The Q.brixx Module D107 has sixteen digital inputs. The pin 
assignment of the two connector strips is identical and the con-
nection terminals have numbers for identifying the connections. 
You will find the associated figures in each case at the same place 
in the circuit diagrams, for example each of the figures quoted in 
the second place belong to one possible connection method.

The designations 0 V (GND) and +V refer to the supply voltage 
connections for supplying the sensors. NC signifies “No Connec-
tion”. Both terminals are electrically isolated from one another 
and from the module supply voltage.

Fig. 4-86 Pin assignment and circuit variants for the Q.brixx Mod-
ule D107.

 4.24.1 Digital input

On each connecting plug contacts for three inputs are available. 
You can use the inputs as a differential input or as a ground-ref-
erenced (single-ended) input. Since in each case the inputs termi-
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nals are electrically isolated from one another and from the sup-
ply voltage, you also have to connect GND (0 V) even with 
differential inputs.

A supply voltage (+V) of 5 V and max. 150 mA per terminal is 
available for supplying the connected sensors.

The digital input is active (high level) when the applied signal 
voltage lies above the threshold. In the differential measurement 
mode the threshold can be set in 256 steps between -20 V and 
+20 V, otherwise between 0 V and +26 V.

The following table shows possible combinations of contact 
assignments for the inputs on Plug 1 (Dx = Sensor x):

1) e.g. status input, frequency measurement or counter
2) e.g. counter with additional input for counting direction (forwards/reverse counter) or 2-

phase counter signals (quadrature counter) or frequency measurement with direction de-
tection (torque transducers)

3) e.g. 2-phase counter signal or angle sensor with additional input for zero reference

The following illustrations show examples for the connection of 
various sensors. Here, in each case only one sensor and one vari-
ant is shown. For example, for the sensor in Fig. 4-88 or Fig. 4-89 
you can also use connections 5/6 and 8/9 and the connections 2/3 
for a standard sensor or digital input. The connection of a single 
digital input is not considered in illustrations. If your are connect-
ing more than one sensor per terminal, you can mix ground-refer-
enced and differential configurations.

Operating mode

 Plug.Contact (assignment)

 1.2
(A1+)

1.3
(A1‒)

1.5
(B1+)

1.6
(B1‒)

1.8
(Z1+)

1.9
(Z1‒)

1.10
(0 V)

3 x standard1), differential D11+ D11‒ D21+ D21‒ D31+ D21‒  GND

3 x standard, single-ended D11+ — D21+ — D31+ — GND

1 x 2 sensor signals2) + 
1 x standard, differential

D11+ D11‒ D12+ D12‒ D21+ D21‒ GND

1 x 2 sensor signals + 
1 x standard, single-ended

D11+ — D12+ — D21+ — GND

1 x 3 sensor signals3), dif-
ferential

D11+ D11‒ D12+ D12‒ D13+ D13‒  GND

1 x 3 sensor signals, sin-
gle-ended

D11+ — D12+ — D13+ — GND
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Fig. 4-87 D107, sensor with one signal, single-ended or differential 
(input broken line).

Fig. 4-88 D107, sensor with two signals (counting direction), sin-
gle-ended or differential (input broken line).

Fig. 4-89 D107, sensor with two signals (90° offset), single-ended 
or differential (input broken line).

Fig. 4-90 D107, sensor with three signals (2 x 90° offset and zero 
reference), single-ended or differential (input broken 
line).
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4.25 Q.brixx S104: Supply Module

The Q.brixx Module S104 is used for supplying active sensors or 
other peripherals and provides four electrically isolated supply 
voltages on two connector strips: 5 VDC, 12 VDC, 15 VDC and 

24 VDC. The output power is 5 W per voltage. The assignment of 

the two connector strips is identical and the contacts of the first 
connection terminal are connected to the same type of contacts 
on the second connection terminal. The connection terminals 
have numbers for identifying the connections.

GND identifies the ground connection (0 V) of a supply voltage 
and the corresponding supply voltage is stated after it in brack-
ets. NC signifies “No Connection”.

Fig. 4-91 Pin assignment for Q.brixx Module S104.
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4.26 Replacing a module

Since the configuration of a module is also saved in the base of 
the module which is permanently connected to the rear panel of 
the Q.brixx system, you can easily replace one module by another 
one of the same type, e.g. if you want to use a module with differ-
ent connections (D-sub or thermocouple sockets).

Since the module configuration is also stored in the module base, 
it is sufficient to just replace the module. The configuration pres-
ent in the base is automatically transferred into the module when 
the power supply is switched on.

Procedure for replacement

1. Switch off the power supply to the Q.brixx system.

2. Release the screws of the module at the front of the Q.brixx 
system (refer to red marking in Fig. 4-92) with a cross-tip 
screwdriver.

3. Withdraw the module towards the front.

4. Push in the new module from the front (note the guiding 
grooves).

5. Retighten the module screws.

6. Switch on the power supply to the Q.brixx system.

The module will now be configured from the base (flashing 
LEDs). When LEDs cease to flash, the configuration is con-
cluded and the module is ready for operation.

Fig. 4-92 To remove a module release the screws in the blue circles 
on the rear panel.
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4.27 Replacing/changing the module type

If you are using a different type of module, the configuration is 
not loaded from the module base, because a different module 
type is involved.

The procedure is initially described in Section 4.27. Accordingly, 
you have to transfer the current or a new configuration into the 
base.

Transferring the configuration to the base

On saving a configuration, e.g. with the ICP 100 program or the 
test.commander program, the (new) configuration is automati-
cally transferred into the base. In this way it is ensured that the 
same configuration is always present both in the base and in the 
module.

4.28 Adding modules to or removing them from the 
system

A change in the number of modules can only be made by Gantner; 
for this please contact the support, e.g. via www.gantner-instru-
ments.com.
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5 Configuration

IMPORTANT
In the description of this chapter screen shots are sometimes 
illustrated. The pictures were generated with modules from the 
Q.bloxx system, but they are almost identical to the pictures that 
you see with Q.brixx; only the name differs (Q.bloxx instead of 
Q.brixx).

You must first establish contact with the module before you can 
configure it. Use the test.commander program for this purpose.

For the program a license number is needed which you have to 
enter to be able to save configurations. During the installation of 
test.commander, the software ICP 100 is also installed and, with 
the licensing of test.commander, is also enabled. You will find the 
license numbers in the PDF file enclosed with the supplied items 
and on the separate printout with your license data.

The manuals and online help for the programs provide a compre-
hensive description of all program options. The following 
describes the most important settings to obtain a system suitable 
for acquiring measurements.

Tip
Use the test.commander Wizard for the initial setup.

If you already have a configuration file with the required settings 
available, you can load this file into the relevant module with the 
Program Controller Setup Wizard (included in test.commander) 
or ICP 100.

IMPORTANT
If you would like to combine modules or Test Controllers from 
older applications and recently purchased ones, all components 
should use the latest relevant internal software, the so-called 
firmware. To ensure this, carry out a firmware update; refer to 
Section 5.10, page 112.

Basic procedure

• Establish the connection (communication) between the PC 
and Test Controller.

• Start the configuration program.

• Enter the sensors used and their sensitivities to obtain an 
indication in the measured physical quantity.
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• Define computations, digital inputs/outputs, alarm monitor-
ing, etc.

• Activate all settings in the module and Test Controller.

Tip
At many points in the programs you can call the setting dialogs or 
settings via the context menu of an entry. You call the context 
menu with the right mouse key.

5.1 Installing the test.commander

➡ We recommend that you close all open programs before the 
installation.

Insert the Gantner CD into your CD drive. In the standard config-
uration Windows opens the CD automatically and a start window 
appears. If you have deactivated the Windows autostart function, 
find the file StartUp.exe in the main directory on the CD and give 
the corresponding symbol a double click to obtain the start win-
dow. Alternatively, you can also start the program Setup.exe in 
the folder test.commander to carry out the installation directly.

➡ The program ICP 100 is installed together with the program 
test.commander.

You will also find the relevant latest versions of the programs on 
our home page www.gantner-instruments.com.

Procedure • Click on the symbol over Load software.

• Click on the symbol  next to the program which you 

want to install.

The program Setup.exe is started.

• Allow the file to open so that the installation can start.

The starting dialog of the setup program appears. 

• Follow the instructions of the setup program to define the 
installation directory and the program group for the software.

Setup.exe creates the directory you have specified, if neces-
sary and then copies all files to it.

When the program test.commander is started for the first time, 
you specify the language for the program user interface (you can 
change your selection at any time via Extras > Settings > Lan-
guage). 

Then enter your license data via Help > Info and Licensing. If 
you have licensed the program test.commander, then the pro-
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gram ICP 100 is also enabled and a further license is not 
required.

5.2 Using test.commander

You can use the program test.commander, when a Q.gate Test 
Controller is present in your configuration. For the configuration 
no module or Test Controller needs to be connected; you can 
carry out the configuration also off-line. For initial operation we 
recommend though that all modules are connected.

5.2.1 Linking test.commander via Ethernet (TCP/IP)

Tip
Use the serial interface (refer to Section 5.2.2, page 84), if a per-
manent IP address (no DHCP) has already been set on the Q.gate 
Test Controller, but you no longer know what it is. Other than 
that, you cannot establish any link between the module and PC 
with “incorrect” address ranges.

Procedure 1. Connect the PC and Q.gate Test Controller via the Ethernet 
interface.

2. Start the program.

Now you have two options: Either you can use the Initial 
Operation Wizard or you can close the starting dialog with 
Cancel and proceed as described in the following. If you want 
to use the wizard, then simply follow the instructions in the 
dialog.

3. Call the program for configuration via the menu Utilities > 
Module Setup Wizard.

4. In the program window and using the menu Options > Com-
munication settings, specify the setting TCP/IP via con-
troller as the Interface type and activate Use scan for IP 
addresses.

For the Ethernet address you can either execute a scan in the 

address range of the PC interface (a UDP Scan1 is executed) 
or directly enter a single address for Q.gate. If required, ask 
the network administrator to enable these scan methods and 
access of the program through the firewall to the Test Con-
troller.

If you use, e.g. 15 seconds, for the Add. (itional) timeout, an 
attempt to establish connection is interrupted after this 

1) With the UPD Scan all devices in a network are addressed simultaneously. The scan is therefore 

executed very quickly.
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period. The option only needs to be used for very slow net-
works or links via radio, etc.

5. Search for the modules: Find modules.

If you receive a firewall message during the search, you have 
to allow access to the Program Setup Wizard in order to be 
able to establish a connection (requires administrator rights), 
refer also to Section 6.1.3, Allowing access to network 
devices (firewall), page 118.

First the Test Controllers found are displayed after the 
search. Mark the Test Controller to which the modules to be 
set are connected and click on OK. The Test Controller is 
addressed and the modules which have been found connected 
to it are displayed in a list.

If files with the module settings exist, you can transfer them to 
the marked modules using Configure selected modules. Other-
wise, create a project for the configuration (Section 5.2.3).

IMPORTANT
If, when reading out the module settings via the Test Controller 
(step 5.), the message appears that the firmware version of the 
Test Controller or of a module is older than expected, then you 
should carry out a firmware update; refer to Section 5.10, Firm-
ware update, page 112.

5.2.2 test.commander and the serial (service) interface

test.commander uses the serial interface exclusively as a service 
interface for the  Q.gate Test Controller to set the IP address for 
Ethernet. Setting connected modules is not possible via this 
interface. 

Procedure 1. Connecting the PC and module via the interface.

Use the supplied cable with the jack plug for the connection 
to the PC interface; refer also to Section 4.2.2, page 17.

2. Start the program1.

3. Using the menu Utilities, call the menu item Controller 
Serial Terminal.

4. In the program window using the menu Options > Commu-
nication Settings, specify the setting RS232 direct con-
nection as the interface type as well as the PC COM port 
used.

1) If you are not initially creating a project, close the starting dialog with Cancel.
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5. Call the program for the settings via the menu Utilities > 
Controller serial terminal.

The program searches the above specified interface for the 
Test Controller and presents you with a dialog in which you 
can read out the existing settings (Read) or set a new Ether-
net address (and subnet mask) or DHCP (Write).

5.2.3 Creating a project for configuration

A project contains the hardware setup, the sensor and I/O set-
tings present in the modules as well as the sensor signals used 
and computations, the so-called variables, which are to be output.

Procedure 1. After the start of the test.commander you are offered several 
options. Select Open new project and read in online sys-
tem.

The network to be searched is defined when the link is estab-
lished; refer to Section 5.2.1 to Section 5.2.2, ff. page 83.

Alternatively, you can also create a project in the test.com-
mander with File > New project and specify the Test Con-
troller used via the context menu Add online controller.

2. In the dialog mark the Test Controller which is mounted on 
the modules to be set and click on OK.

The existing module settings are read out and the Test Con-
troller information updated via the connected modules. Con-
firm any changes to be made in order to retain the current 
state.

3. A dialog finally shows you that all settings have been success-
fully read from the Test Controller. Acknowledge this with a 
click on OK.

In your project the selected Test Controller is now displayed as 
the main entry. A tree structure similar to that in Windows 
Explorer shows the connected (found) Q.brixx modules and the 

variables used. Open up the entries as required by a click on .

Mark a module and select Configuration from the context menu 
or double click on a module or signal (variable) to start the con-
figuration program ICP 100. Then carry out all the module set-
tings in the window of this program.

IMPORTANT
After changes to the configuration of modules or a Test Con-

troller  is displayed in the project tree. Select  or File > 
Write project (update) in the test.commander to update the 
settings in the project (and in the Test Controller). The project 
file is in this case automatically saved. 
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Tip
You process a complete variable in the configuration dialog in 
that you click on the variable in the left column (contains the vari-
able number Vx) to mark it. Using the context menu, you can then 
cut, paste and copy the variable, overwrite it with a copied vari-
able or delete it.
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5.3 Setting sensor parameters

In order to set parameters you should be connected to the mod-
ule and have called the configuration program (ICP 100 which is 
started automatically by test.commander): Mark a module and 
select Configuration from the context menu or double click on a 
module or module signal (variable) to start the configuration pro-
gram. Then carry out all the module settings in the window of this 
program.

You can however also configure a project without a direct con-
nection and then, once you have established the connection, load 
the corresponding files into the modules and load Test Controller.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition in the configuration 
program.

Fig. 5-1 Dialog with the configuration for force transducers (6-
wire) and voltage input.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Analog. Input.

3. Click in the column Variable name and allocate a name iden-
tifying the signal from the connected sensor.

4. Click in the column Sensor and specify the type of sensor.

Depending on the type of module, you have various options 
available, e.g. Bridge for strain-gauge full and half-bridges, 
Pt100, Resistance for resistors or Voltage for voltage mea-
surements and IEPE sensors.

5. Click in the column Type of and specify the type of circuit or 
further information about the sensor type.
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Depending on the selected sensor type, you have various 
options available, e.g. 2-wire or 4-wire (circuit) for resistive 
transducers or Full 4-wire or Full 6-wire (circuit) for strain-
gauge full bridges.

The column Wiring diagram shows you the pin assignment 
to be used. With more than one input the first inputs are also 
always occupied first (and first Plug 1, then Plug 2, etc.). 
Check that your sensor is connected correctly.

6. Click in the column Format/balance to enter the scaling for 
the sensor.

Depending on the type of sensor selected, you have various 
options available (refer also to Section 6.3, Sensor scaling, 
page 121):

– For voltage signals specify the conversion of the measured 
voltage to the physical quantity measured by the sensor or 
output the measured voltage quantity without conversion 
(scaling).

– For thermocouples or Pt100 sensors no further scaling is 
required as the conversion into °C is made automatically. 
The scaling is only needed when you want to convert to °F 
or K. In this case enter the Unit (type into the field) and 
then click on Scaling. Using the method Factor and off-
set. For a display in °F enter the factor 1.8 and 32 as the 
offset. For a display in °K enter the factor 1 and -273.15 
as the offset.

– For full and half-bridge transducers you can obtain the 
data from the data sheet or (better) from the transducer 
calibration certificate. For a force transducer with, for 
example, 2.03mV/V at 5kN enter the Unit (type kN in the 
field) and then click on Scaling. Using the method 2-
point calibration. Enter in each case 0 for Point 1 for 
Measurement and Displayed value and 2.03 as Mea-
surement and 5 as Displayed measurement for Point 
2.

Alternatively, you can also enter N as Unit and then 5000 
as Displayed value for Point 2.

– For strain gauges you have the Strain gauge calculator 
available. Here, the unit is automatically changed to μm/
m. In the dialog enter the gauge factor of your strain 
gauge (left field) and the bridge factor (right field) for 
your circuit.

Floating point numbers are always transferred as 4-byte val-
ues and further setting is not necessary here.

For the formats Integer (2 bytes) and Long integer (4 bytes) 
specify the number of Decimal places and the total number 
of places to be output (Field length). The field length is cal-
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culated including the points, but without any commas dis-
played for the thousands positions and it is only used for rep-
resentation in one of the Gantner programs. Specifying three 
decimal places displays, for example, the value 1234 as 1,234.

After closure of the dialog the number of transferred places 
and the unit are displayed in the column Format/balance, 
e.g. ff,fff.f [kN] for an output in the unit kN with a total of 
seven characters with one decimal place and the decimal 
point.
If negative numbers occur, the display in this example is lim-
ited to -9,999.9 (seven characters without the comma).

7. Click in the column Range/error to limit the admissible value 
range and to define the reaction in the case of an error 
(optional).

8. Also optionally, you can specify filtering of the sensor signal 
in the column Other.

9. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

The file is created within the project folder and the file name 
is generated automatically. The project folder bears the same 
name as the project. The generated file name contains the 
address of the Test Controller through which the module is 
connected and an identifier for the relevant module.

IMPORTANT
If the modules are connected through a Test Controller, new 

module settings must also be updated there. Select  or File 
> Write project (update) in the test.commander. The project 
file is in this case automatically updated.

5.3.1 Carrier frequency synchronization (Q.brixx A106)

The A106 module supports the supply of sensors with direct volt-
age (DC) or carrier frequency (CF).

➡ If you are using several modules of this type and set carrier fre-
quency supply, you should synchronize the carrier frequencies of 
the modules, because otherwise crosstalk can occur between the 
supply lines and the signal inputs of different modules. This then 
leads to beats in the measurement signal.

After selecting a carrier frequency, you have three methods of 
supply:
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1. No sync. (hronization)

This setting is practicable when you are only using one mod-
ule with carrier frequency supply. Within a module all carrier 
frequency generators are automatically synchronized.

2. Internal sync. (hronization)

Set this type of synchronization for one module. The module 
then becomes the master to which all other modules synchro-
nize.

3. External sync. (hronization)

Specify this type of synchronization for all other modules so 
that they synchronize to the master.

Tip
We recommend that only one variant of the carrier frequency is 
used, i.e. do not mix 600 Hz and 4800 Hz.

4. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

5.3.2 Zero balancing/taring the sensor

You have two ways of setting a measurement offset to zero, e.g. 
due to preloads:

1. Zero balance

With this method measurement takes place over a certain 
time period and the mean is computed. This mean value is 
then subtracted from all the following measurements.

2. Taring

With this method the (single) measurement present at a cer-
tain point in time is subtracted from all the following mea-
surements.

Procedure 1. Click in the column Type of the first free row (V3 = Variable 3 
in Fig. 5-2) or mark the row (click on V3) and use Variable 
definition > Type.

2. Select Default.

3. Click in the column Variable name and allocate a name spec-
ifying the purpose of the signal, e.g. Zero_tare (Fig. 5-2).
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Fig. 5-2 Defining the variable for zero balancing and/or taring.

4. Click in the column Format/balance of the channel for which 
zero balancing and/or taring is to be executed, e.g. for the 
strain-gauge force sensor in Fig. 5-2.

Fig. 5-3 Dialog for sensor scaling.

5. Click on Zero balance or Tare to configure the relevant pro-
cess.

6. Select the variable created above as the control variable 
(Fig. 5-4).

Fig. 5-4 Setting up zero balance or tare.
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When the variable (Zero_tare in this example) has certain val-
ues, taring or zero balancing is carried out or an existing zero 
or tare value is deleted (undo zero balancing/taring):

7. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

5.3.3 Sensor scaling over several points (table)

In the standard setting (linear) sensors are scaled via a charac-
teristic curve with two points. You can however also perform scal-
ing over several points (table). During the measurement the val-
ues are then linearly interpolated between the specified points.

Procedure 1. Create the sensor as usual (two-point scaling).

2. In the Sensor column click on the sensor.

3. Copy the sensor (click on Copy) and specify a name, e.g. 
ForceTable (Fig. 5-5). If the scaling to be entered later only 
applies to this sensor, you should use the sensor type and the 
serial number as the name, e.g. C2 #1234 (5V).

Value Function

1 Perform taring when setting the value

2 Reset tare (delete tare value)

4
Start zero balance The mean is formed until the value 0 
is written to the variable again.

8 Reset zero balance (delete zero value)
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Fig. 5-5 Creating a new sensor for scaling.

4. Click on Edit and the Unit tab to be able to define the unit 
measured by your sensor (Fig. 5-6).

Fig. 5-6 Defining the unit for sensor scaling.

5. Specify the required unit, e.g. kN (Fig. 5-6).

6. Click on Linearize and select your unit.
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7. Edit the existing values or generate further rows with New 
and specify the values for your sensor (Fig. 5-7). The rows 
sorted based on the entered values.

Fig. 5-7 Entering the scaling table.

If the data are present in an Excel file, you can also import a 
file in the format Excel 97-2003-Workbook (*.xls).

Alternatively to entering a unit in step 5, you can leave the 
electrical unit of the sensor as it is and enter the table in this 
unit, e.g. mV/V measured value and mV/V displayed value. 
You can then define the unit displayed for the measurement in 
the column Format/balance column.

8. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.
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5.4 Specifying digital inputs/outputs

In order to set parameters you should be connected to the mod-
ule and have called the configuration program (ICP 100 which is 
started automatically by test.commander): Mark a module and 
select Configuration from the context menu or double click on a 
module or module signal (variable) to start the configuration pro-
gram. Then carry out all the module settings in the window of this 
program.

You can however also configure a project without a direct con-
nection and then, once you have established the connection, load 
the corresponding files into the modules and load Test Controller.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition in the configuration 
program.

Fig. 5-8 Dialog with configuration for digital input and output.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Digit. input or Digit. output.

The column Wiring diagram shows you the pin assignment. 
With more than one input the first inputs are also always 
occupied first (first Plug 1, then Plug 2, etc.). Check for cor-
rect connection.

3. Click in the column Variable name and allocate a name iden-
tifying the signal.

4. At a digital output click in the column Type of and specify 
whether you want to use the output as Status indicator, Sta-
tus field or Process output. 

Process output: The output monitors a module signal and 
changes the output level under certain conditions. Click in the 
column Other and specify the type of alarm monitoring.
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You can specify up to four alarm conditions. When one of 
the conditions is satisfied, the alarm signal is triggered. 

To the left above the graphical displays select the levels at 
which switching is to occur and how they are to switch. 
Enter the values for the switching thresholds in the 
(scaled) unit of the selected signal. Use either fixed values 
(constants) or arrange for the values to be determined by 
other variables.

Status indicator: The output can be set via a command from 
the Test Controller, e.g. via a PROFIBUS-DP command. Click 
in the column Other and specify the type of alarm monitoring.

5. Click in the column Format/balance to specify the transfer 
format.

Since digital signals do not require any Decimal places, you 
can enter 0 here. 1 is sufficient for the Field length. With a 
digital input you can also specify a unit (optional).

For several inputs/outputs and the type Status field (Type of 
column), as well as the transfer as a number (e.g. as integer), 
there is also the type Status field 32 with which all existing 
inputs or outputs are transferred as binary numbers. Define a 
suitable field length here depending on the number of inputs 
and outputs.

When the dialog is closed, the number of transferred places 
and the unit in the column Format/balance are displayed.

6. Click in the column Range/error to define the reaction in the 
case of an error for the digital outputs (optional).

7. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

The file is created within the project folder and the file name 
is generated automatically. The project folder bears the same 
name as the project. The generated file name contains the 
address of the Test Controller through which the module is 
connected and an identifier for the relevant module.

IMPORTANT
If the modules are connected through a Test Controller, new 

module settings must also be updated there. Select  or File 
> Write project (update) in the test.commander. The project 
file is in this case automatically updated.

5.5 Defining analog outputs

In order to set parameters you should be connected to the mod-
ule and have called the configuration program (ICP 100 which is 
started automatically by test.commander): Mark a module and 
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select Configuration from the context menu or double click on a 
module or module signal (variable) to start the configuration pro-
gram. Then carry out all the module settings in the window of this 
program.

You can however also configure a project without a direct con-
nection and then, once you have established the connection, load 
the corresponding files into the modules and load Test Controller.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition in the configuration 
program.

Fig. 5-9 Dialog with configuration for analog outputs.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Analog. Output.

The column Wiring diagram shows you the pin assignment. 
With more than one output the first outputs are also always 
occupied first (first Plug 1, then Plug 2, etc.). Check for cor-
rect connection.

3. Click in the column Variable name and allocate a name iden-
tifying the signal.

4. Click in the column Type of and specify whether you want to 
use the output as a Voltage or a Current output. 

5. In the Format/balance column the output format is shown 
which has no further significance here.

6. Click in the column Range/error to define the output scaling 
and the reaction in the case of an error (optional).

7. Click in the column Other to specify the signal source (vari-
able) used for the output.

8. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.
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The file is created within the project folder and the file name 
is generated automatically. The project folder bears the same 
name as the project. The generated file name contains the 
address of the Test Controller through which the module is 
connected and an identifier for the relevant module.

IMPORTANT
If the modules are connected through a Test Controller, new 

module settings must also be updated there. Select  or File 
> Write project (update) in the test.commander. The project 
file is in this case automatically updated.
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5.6 Defining computations

In order to set parameters you should be connected to the mod-
ule and have called the configuration program (ICP 100 which is 
started automatically by test.commander): Mark a module and 
select Configuration from the context menu or double click on a 
module or module signal (variable) to start the configuration pro-
gram. Then carry out all the module settings in the window of this 
program.

You can however also configure a project without a direct con-
nection and then, once you have established the connection, load 
the corresponding files into the modules and load Test Controller.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition in the configuration 
program.

Fig. 5-10 Dialog with configuration for a computation.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Arithmetic.

3. Click in the column Variable name and allocate a name iden-
tifying the signal.

4. Click in the column Other and specify the required computa-
tion.

In the upper dialog field you can enter, as on a pocket calcula-
tor, a formula which uses the existing module variables. Cre-
ate functions via the buttons in the lower section of the dialog. 
Click on OK once you have defined the required computation.

5. Click in the Format/balance column to specify the transfer 
format using the formats Integer (2 bytes) and Long integer 
(4 bytes).
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Floating point numbers are always transferred as 4-byte val-
ues and further setting is not necessary here.

For the formats Integer and Long integer specify the num-
ber of Decimal places and the total number of places to be 
output (Field length). The field length is calculated including 
the points, but without any commas displayed for the thou-
sands positions and it is only used for representation in one of 
the Gantner programs. Specifying three decimal places dis-
plays, for example, the value 1234 as 1,234.

After closure of the dialog the number of transferred places 
and the unit are displayed in the column Format/balance, 
e.g. ff,fff.f [kN] for an output in the unit kN with a total of 
seven characters with one decimal place and the decimal 
point.
If negative numbers occur, the display in this example is lim-
ited to -9,999.9 (seven characters without the comma).

6. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

The file is created within the project folder and the file name 
is generated automatically. The project folder bears the same 
name as the project. The generated file name contains the 
address of the Test Controller through which the module is 
connected and an identifier for the relevant module.

IMPORTANT
If the modules are connected through a Test Controller, new 

module settings must also be updated there. Select  or File 
> Write project (update) in the test.commander. The project 
file is in this case automatically updated.

5.7 Specifying the alarm monitoring

In order to set parameters you should be connected to the mod-
ule and have called the configuration program (ICP 100 which is 
started automatically by test.commander): Mark a module and 
select Configuration from the context menu or double click on a 
module or module signal (variable) to start the configuration pro-
gram. Then carry out all the module settings in the window of this 
program.

You can however also configure a project without a direct con-
nection and then, once you have established the connection, load 
the corresponding files into the modules and load Test Controller.

All module signals are defined as variables. Therefore, for the 
entry activate the tab Variable definition in the configuration 
program.
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➡ In order to monitor a limit and to output a level on a digital output 
when an alarm occurs, you can directly use the function of the 
digital output. You do not need to set up any alarm monitoring. 
The alarm monitoring is used to monitor signals in the module 
and to make the result available to the PC or PLC as a precondi-
tioned signal. Checking the original signal in the PC or PLC can 
therefore be omitted.

Procedure 1. Click in the column Type of the first row (V1 = Variable 1) or 
mark the row (click on V1) and use Variable definition > 
Type.

2. Select Alarm.

3. Click in the column Variable name and allocate a name iden-
tifying the alarm signal.

4. Click in the column Other and specify the type of alarm mon-
itoring.

You can specify up to four alarm conditions. When one of the 
conditions is satisfied, the alarm signal is triggered. 

To the left above the graphical displays select the levels at 
which switching is to occur and how they are to switch. Enter 
the values for the switching thresholds in the (scaled) unit of 
the selected signal. Use either fixed values (constants) or 
arrange for the values to be determined by other variables.

5. Click in the column Format/balance to specify the transfer 
format.

Since the alarm signal, like digital signals, does not require 
any Decimal places, you can enter 0 here. 1 is sufficient for 
the Field length.

When the dialog is closed, the number of transferred places 
and the unit in the column Format/balance, e.g. f, are dis-
played.

6. Save the changes in a file and close the module once you have 

made all the changes:  or File > Save to file and finish.

The file is created within the project folder and the file name 
is generated automatically. The project folder bears the same 
name as the project. The generated file name contains the 
address of the Test Controller through which the module is 
connected and an identifier for the relevant module.

IMPORTANT
If the modules are connected through a Test Controller, new 

module settings must also be updated there. Select  or File 
> Write project (update) in the test.commander. The project 
file is in this case automatically updated.
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5.8 Q.gate settings

In the Test Controller you specify, for example, the type and 
scope of the synchronization, set the (synchronous) output rate 
and baud rate of the modules to be used or define which bus diag-
nostic data or life signs are to be transmitted. In addition, you can 
check all the settings of host and module interfaces, allocate a 
location name, etc. The following sections only deal with the most 
important settings; for further information read the appropriate 
Test Controller manual.

Mark the Test Controller to be set and select Settings from the 
context menu or double click on the Test Controller to start the 
configuration program. Then you can carry out all the module 
settings in the window of this program. A tree structure similar to 
that in Windows Explorer shows the individual parameter groups. 

Open up the entries as required by a click on .

Fig. 5-11 Configuration dialog for a Q.gate. Test Controller

5.8.1 Module interface

Using this parameter group, the speed of data transmission on 
the individual interfaces (UARTs) can be defined. Since all mod-
ules are brought together in one housing with Q.brixx, here the 
maximum possible baud rate of 48 MBd can be used.

A change in the baud rate is carried out automatically on all con-
nected modules.

Communication monitoring: With a value > 0 the module 
error LED is activated if there is a lack of communication after 
this period.

Response delay: This parameter is only needed when the mod-
ules are not directly connected to this interface, but instead con-
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nected to a modem, for example. Then enter the time here which 
is to be awaited additionally due to the slow connection.

5.8.2 Host interface

This parameter group defines the settings for communication 
with the host(s) (PC, PLC, etc.).

Since the Test Controller can also operate as an FTP server and 
FTP client, the settings for sending e-mails, for example, can also 
be defined here. Further information on these parameters can be 
found in the System Guide Manual.

5.8.3 Settings

Using this parameter group you define, for example, life signs or 
the location name. 

5.8.3.1 General remarks

Location Here, assign a name for the Test Controller.

Buffer pre-initialization In the Fast filling default setting each measurement transferred 
with a bit error leads to an error: the measurement is set to -1 
(default setting for Filling pattern) and the error counter is set. 
This generally causes the test-rig to stop. In the setting Deacti-
vated the previous measurement is also used for the present 
measurement. If the next measurement is alright again, measure-
ment continues as normal. The error is however counted, but no 
alarm is triggered.

Filling pattern Value which is used for a defective measurement (refer to Buffer 
pre-initialization).

5.8.3.2 Life sign

Here you specify the communication errors for which an error 
signal is to be set and whether it is to occur as a static signal or 
dynamically (switching between on and off with the I/O status 
cycle).

5.8.3.3 Synchronization

Synchronous sampling fre-

quency

If you are using several modules on various interfaces (UARTs), 
which operate at different sample rates, for example because not 
all modules support the same sample rate, then with this parame-
ter you can ensure that those values transferred over an interface 
(UART) with a slow sample rate are also synchronized to the time 
points at which a measurement is also present that has been 
acquired with a fast sample rate (Fig. 5-12).
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Fig. 5-12 Data transmission at a synchronous sampling frequency. 

When using several Q.pac Test Controllers, additionally specify 
which is used as master (Use as master: Yes) and which are 
used as slaves. The master (only one master is permissible) 
defines the synchronization and then all slaves synchronize them-
selves to the master. 

Time synchronization If you want to use either several systems or to synchronize your 
system through an external time source, you must specify how 
the synchronization is to occur (refer also to Section 4.3, 
page 19).

1. Synchronization of several  Test Controllers through one sync 
line

Connect the sync connections on the Test Controllers by syn-
chronization lines. For this purpose use a screened cable with 
twisted cores if possible. One (any) controller becomes the 
master; on this controller set Settings > Synchronization > 
Sync. protocol settings to None. For the other Test Con-
trollers specify Q.sync over RS485 as the setting in the same 
dialog.

The maximum length of all synchronization lines together is 
1000 m.

2. Synchronization of a Test Controller through a radio receiver 
for time signals

Connect the receiver by the sync line; refer to Section 4.3.1, 
page 21. Depending on the output signal, specify AFNOR via 
RS485 or IRIG B003/B005 via RS485 for Settings > Syn-
chronization > Sync. protocol settings. With a Q.gate Test 
Controller no further Test Controllers can be connected in 
this case. This is only possible in conjunction with an (addi-
tional) Q.pac Test Controller.

3. Synchronization of a Test Controller through a GPS receiver

Connect the GPS receiver with the RS-232 interface of the 
Test Controller and specify NMEA-0183 for Host interface 
> RS 232 > Protocol.

4. Synchronization of a Test Controller through SNTP

Sample rate 1

Sample rate 2, not 
synchronized

Sample rate 2, 
synchronized
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Make sure that the Test Controller can access a time server in 
the Ethernet network. Specify On for Host interface > 
SNTP > SNTP mode as well as the Server address (IP 
address of the time server).

All other variants are combinations of theses methods:

1. Synchronization of several Test Controllers through one sync 
line; the master controller can be synchronized through a 
GPS receiver or SNTP.

Set the master up as described above (Settings > Synchro-
nization > Sync. protocol settings remains on None). On 
the slave controllers specify Q.sync over RS485 for Settings 
> Synchronization > Sync. protocol settings.

2. Synchronization of several Test Controllers through one radio 
receiver for time signals in conjunction with an additional 
Q.pac Test Controller

Connect the time signal on the Q.pac Test Controller to the 
digital IOs  (plug terminal 2, connections 9 and 10). Connect 
the Q.pac Test Controller to the Q.gate Test Controllers 
through the sync lines. Depending on the output signal, spec-
ify AFNOR via IOs or IRIG B003/B005 via IOs for Settings 
> Synchronization > Sync. protocol settings on the Q.pac 
Test Controller. On the slave controllers specify Q.sync over 
RS485 for Settings > Synchronization > Sync. protocol 
settings.

3. Synchronization of several Test Controllers through SNTP 
(without sync line)

On all Test Controllers specify On for Host interface > 
SNTP > SNTP mode as well as the Server address (IP 
address of the time server).

5.8.3.4 Ring buffers

In each case a ring buffer is available. When reading data from 
the buffer, all the (new) data are retrieved which are present in 
the buffer. With the maximum buffer size (16 Mbyte is available) 
the transfer may take some time. Reduce the buffer if data are 
retrieved from the buffer only sporadically or not much data is 
involved.

5.8.4 System variable

IMPORTANT
The system variable created in the default setting for the time or 
the cycle counter (Cyclecounter) must not be changed.
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Here, you specify in which format the time signature is to be 
recorded: Context menu for system variables Add new variable 
> ABSDATETIME. After a double click on the variable and a fur-
ther click on Formula you can also select other formats (Fig. 5-
13).

Fig. 5-13 Dialog for specifying the time format.

5.8.5 Virtual variable

With virtual variables you can carry out computations, evaluate 
trigger conditions or carry out assessments. The variables can be 
output like measurements or linked to other variables, measure-
ments or digital I/Os.

In the context menu for virtual variables select Add new vari-
able > ARITHMETIC_EMPTY. After a double click on the vari-
able you can either specify a formula for the computation, define 
an event which is to be monitored (trigger) or specify the data 
format to be used (Fig. 5-14).
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Fig. 5-14 Configuration dialog for a virtual variable.

Click on, for example, Formula to enter a computation (Fig. 5-
15).

Fig. 5-15 Defining a computation (formula).
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In the dialog you have available all variables already defined (tab 
V1-10 and other tabs if more than ten variables have been 
defined). Click on one of the variables to insert it into the for-
mula. Use the field Functions and operators to select a mathe-
matical or logical function (select the function and click on 
Select function so that it is accepted into the formula field). 
Where required add brackets (simply enter them via the key-
board) in order to obtain the correct computational sequence. 
Close the dialog with OK.

IMPORTANT

Select  or File > Write project (update) in the test.com-
mander to transfer the new definition into the Test Controller. 
The project file is in this case automatically updated.
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5.9 Online tools

5.9.1 Read data buffer (with measurements) 

Click on  or use File > Read online data buffer from con-
troller to be able to read out and view all values from the ring 
buffer. 

Fig. 5-16 Display of the buffer content with test.viewer.

You can carry out further settings using the menu and symbols, 
e.g. display the channel list, show the spectra or transfer a live 
stream of data.

5.9.2 Displaying measurements

Click on  or use File > Read online values from control-
ler to be able to view the values of your variables. If you have 
defined appropriate variables, you can also set initial values in 
this dialog.
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Fig. 5-17 Dialog for displaying the variable values.

In the dialog click on Show online graphics to display the val-
ues in a graph over time.

5.9.3 Reading module information

Click on  or use File > Read online module info from 
controller to be able to display information such as the address 
or serial number of your system.

Fig. 5-18 Display of the module information.
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5.9.4 Reading status information

Click on  or use File > Read online status info from con-
troller to display status information of your system.

Fig. 5-19 Display of the status information.
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5.10 Firmware update

Recently purchased modules or Test Controllers always contain 
the latest firmware, i.e. the software in the modules or Test Con-
trollers is the current version. However, if you want to combine 
these modules with older modules and/or Test Controllers, you 
must update all older modules or Test Controllers and it is essen-
tial to update your software to the latest version, because other-
wise disturbances in operation due to a communication failure 
may occur.

The current firmware is in each case included in the latest instal-
lations of the programs ICP 100 or test.commander. Here, the 
program licenses apply to all versions of a program. If required, 
download the latest versions from our web site: www.gantner-
instruments.com. You will find the programs under Downloads 
> Software.

5.10.1 Firmware update for Test Controller

Install as required the latest version of the test.commander so 
that you can also install the latest version of the firmware on your 
PC. Before a new installation is carried out, we recommend that 
the existing version is uninstalled using the Windows Control 
Panel.

Procedure 1. In the program test.commander select Utilities > Controller 
firmware update.

The network in the segment of the PC address is searched and 
the Test Controllers which are found are displayed in the win-
dow. If no Test Controller is found, you may have to enter the 
address manually or set the IP address of your PC to the seg-
ment used by the Test Controller; refer also to Section 4.2.1, 
Connecting /Q.gate via Ethernet to a PC/PLC, page 16.

2. Mark the Test Controller to be updated and click on OK.

The update tool is started and the Test Controllers present in 
the network are displayed again.

3. Mark the Test Controller to be updated and click on Update.

The Windows file dialog is opened and shows you the firm-
ware versions available on your PC.

4. Mark the newest of the available firmware versions (if neces-
sary, switch to the detailed view) and click on Open.

The update process is started. Wait until the update has fin-
ished. The end of updating is indicated by the dialog “Update 
completed successfully”.

5. Click on OK and close the window of the update tool. The 
firmware update is now completed.
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5.10.2 Firmware update for modules

Install as required the latest version of ICP 100 or test.com-
mander so that you can also install the latest version of the firm-
ware on your PC.

Procedure 1. In the program test.commander select Utilities > Module 
firmware update. 

2. Make sure that the settings with regard to the interface used 
are correct: Options > Communication settings.

3. Search for the Test Controller or the modules: Find modules.

4. If the modules are connected via a Test Controller, in the next 
window mark the Test Controller to which the modules to be 
updated are connected and click on OK.
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6 Functional Procedures

This chapter explains various important settings and processes 
more comprehensively than in the previous chapters, for exam-
ple, to provide you with decision-making aids for the interface 
parameters or the settings of the modules.

6.1 Ethernet on the PC

The following sections describe various settings which you can 
carry out on the PC to enable a link to be formed. The images use 
menus and dialogs found in Windows XP; the names of the dia-
logs and fields in other versions of Windows are however similar 
and are usually also given.

6.1.1 Finding the IP address and subnet mask of the PC

In Windows 7 or 8 open the Network and Sharing Center, e.g. 

using  at the bottom on the right in the taskbar. Click on the 
LAN connection (the name may be different) through which the 
Test Controller is connected to the PC (Fig. 6-1 on page 116). In 
the following status dialog (similarly in Fig. 6-1) click on Details.

The current address is displayed in the next dialog under IPv4 
address.

The subnet mask determines which addresses can be reached 
from the PC: Only addresses whose figures are identical in the 
places which contain a 255 in the subnet mask can be reached. 
The IP addresses of the PC and Test Controller should normally 
be located in the same Ethernet segment (only the last group of 
figures in the IP address is different), otherwise the subnet mask 
must be 255.255.0.0 so that the last two groups of figures may be 
different.



Vers. No. 2.0
116 Released: 5/07/2016

6     Functional Procedures → Ethernet on the PC

Fig. 6-1 Viewing/changing the IP address of the PC

Example 1 Subnet mask 255.255.255.0, IP address 192.168.100.26

Only addresses can be reached which start with 192.168.100, i.e. 
the first three groups of figures must be identical and only the 
fourth may be different.

Example 2 Subnet mask 255.255.0.0, IP address 192.168.100.26

All addresses can be reached which start with 192.168, i.e. the 
third group of figures may also be different between the PC and 
Test Controller.

6.1.2 Setting the IP address on the PC

If you want to connect to a Test Controller, you must assign a 
(temporary) IP address to the PC.
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➡ We recommend that a temporary IP address is set up on the PC, 
because then the network settings on your PC for the normal con-
nections are not changed. If you have already set up this type of 
“alternative configuration” for another network, you must note 
the existing settings so that you can restore them after conclud-
ing the configuration of modules or the Test Controller.

In Windows 7 or 8 open the Network and Sharing Center, e.g. 

using  at the bottom on the right in the taskbar. Click on the 
LAN connection (the name may be different) through which the 
Test Controller is connected to the PC (refer to Fig. 6-1 on 
page 116). In the following status dialog click on Properties 
(requires administrator rights). Then mark Internet Protocol 
Version 4 and click on Properties (refer also to Fig. 6-2).

Then proceed to the register card Alternative Configuration 
and specify an address for the PC, e.g. 192.168.100.5, and a 
subnet mask, e.g. 255.255.255.0 (Fig. 6-3).

Fig. 6-2 LAN connection properties (Windows 7 and 8)
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Fig. 6-3 Specifying the IP address and subnet mask for an alterna-
tive (temporary) configuration.

6.1.3 Allowing access to network devices (firewall)

Generally, a firewall monitoring access of the PC to the network 
and vice versa is installed on the PC. Therefore, you must allow 
access to the Test Controller or the module, otherwise no connec-
tion can be established via Ethernet. On the first attempt to 
establish a connection you receive a message similar to that 
shown in Fig. 6-4. Click on Unblock to allow the connection.

IMPORTANT
You must possess administrator rights on the PC to be able to 
unblock the connection. If this is not the case, ask your adminis-
trator to do this for you. You must enable all programs for sharing 
which use an Ethernet connection to the modules or the Test 
Controllers.
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Fig. 6-4 Windows firewall message on attempting to establish an 
Ethernet connection.
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6.2 Connecting sensors with sensing leads

Resistive sensors require an excitation voltage to be able to pro-
vide their output signal. For sensor excitation a current is passed 
through the connecting lead, which however causes a loss of volt-
age due to the resistance of the connecting lead. Consequently, 
the sensor is then not supplied with the voltage set on the ampli-
fier module, but rather with a slightly lower voltage. This leads in 
turn to a lower output signal and, depending on the cable resis-
tance, losses in the single-figure percentage range can occur 
even with just a few meters. Therefore, high quality amplifier 
modules for the excitation of resistive sensors use so-called sens-
ing leads which can measure the loss of voltage, since only a very 
small current flows in them. This is because the inputs for the 

sensing leads have very high input resistances (usually over 106 
 compared to a sensor resistance of a few 100 . The amplifier 
module can therefore acquire the voltage arriving at the sensor 
error-free and increase its excitation voltage to compensate for 
the losses in the connecting cable. This is particularly the case 
when the temperature of the connecting cable changes. In this 
case the cable resistance changes and the sensor output signal 
would therefore also change if no sensing leads were used.

We therefore recommend the use of sensing leads. This is mainly 
necessary when several meters of cable are used, low measure-
ment deviations are to be obtained or when the temperature of 
the cable may vary.
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6.3 Sensor scaling

Depending on the type of transducer (Sensor type), you have var-
ious possible scalings available. With voltage signals and strain 
gauge bridges (Bridge), you can define a conversion of the mea-
sured voltage (volts or mV/V) into a physical unit, e.g. in newtons. 
With strain gauges a special conversion tool is available to you.

Click in the column Format/balance of the variables to be set to 
call up the setup dialog (Fig. 6-5).

Fig. 6-5 Setup dialog for scaling.

6.3.1 Scaling of voltage signals and strain-gauge bridges

1. In the Unit field enter the required physical unit, e.g. N. 

If the unit has already been entered, you can select it from the 
list box.

2. Click on Scaling.

The scaling dialog is displayed.

3. Enter the transducer (sensor) data from the calibration certif-
icate or from the data sheet (example: refer to Fig. 6-6 on 
page 122).

Instead of the full scale readings in the positive and negative 
directions, you can also enter just one direction. Then in each 
case use 0 for Measurement and Displayed value at Point 
1.
An alternative is the entry of Factor and Offset if these data 
have been specified for your sensor.

The numbers in the Display field depend on the settings in 
the Range/error column.

4. Close the scaling and setup dialog with OK.
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Fig. 6-6 Scaling dialog

6.3.2 Scaling strain gauges

1. Click on Strain-gauge calculator, the unit is then automati-
cally changed to μm/m.

2. Enter the gauge factor of your strain gauge in the left field.

The gage factor is a measure of the sensitivity of the strain 
gauge and is stated on each strain-gauge pack. It is usually 
between 1.8 and 2.2. Fig. 6-7 shows scaling with k = 2.03.

3. If you are using more than one active strain gauge in your 
bridge circuit, you must also state the resulting bridge factor 
(right field). The factor depends on the orientation of the 
strain gauge on the measurement object and, where applica-
ble, also on the Poisson's ratio for the material. On a tension/
compression bar the bridge factor is, for example, approx. 
between 2.5 and 2.8 depending on the material. 

4. Close the scaling and setup dialog with OK.
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Fig. 6-7 Scaling dialog for strain gauges.
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6.4 Current measurement with an external shunt

Current measurements are carried out by measuring the voltage 
drop across a resistance of known size (shunt resistance). In the 
Q.brixx modules, which are suitable for direct current measure-
ment, this is a resistor of 50 , with which you can measure cur-
rents up to 25 mA (the maximum shunt power dissipation is lim-
ited to 0.25 W). Higher currents need an external shunt which is 
looped into the line to be measured. The power dissipation occur-
ring at the current to be measured must be lower than the per-
missible power dissipation of the external shunt. In addition the 
voltages produced on the resistance must not exceed the permis-
sible input voltage on the analog input of the Q.brixx module. 
Configure the analog input as a voltage input and divide the mea-
sured voltage by Rext.

IMPORTANT
The error in the current measurement using an external shunt 
depends on the accuracy of the resistor used.
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6.5 Measuring with thermocouples

Thermocouples consist of two “thermoelectric wires” which are 
formed from different materials, e.g. platinum and platinum/rho-
dium, and are joined together at one end, usually by welding. If 
this contact point and the other ends of the thermoelectric cables 
have different temperatures, a “thermoelectric voltage” is pro-
duced at the contact point. This voltage is essentially propor-
tional to the temperature difference between the contact point 
and the ends of the cables.

Since thermocouples only measure a temperature difference (dif-
ference between the temperature at the contact point and the 
measured temperature at the terminal strip on the Q.brixx mod-
ule), the terminal temperature must be known or the “transition” 
from the thermocouple cable or compensating cable to the cop-
per cable must occur at a known temperature level. The first case 
is known as internal cold junction compensation (TCint) and the 

second case as external cold junction compensation, TCext.

To acquire the temperature with internal cold junction compen-
sation an additional temperature probe is used which measures 
the reference temperature. For the Q.brixx modules a cold junc-
tion compensation terminal with an integrated Pt1000 tempera-
ture probe is used. In this way, the temperature at the “transition 
point” is determined and the voltage produced by the thermocou-
ple is corrected depending on the type of thermocouple.

To measure the temperature using external cold junction com-
pensation, a second thermocouple of the same type is needed 
which is connected in series with the first one. The polarity is 
chosen such that the thermoelectric voltages subtract. The sec-
ond thermocouple is located at a fixed reference temperature 
(usually 0°C). Then, the Q.brixx module calculates the tempera-
ture at the measuring point based on the linearization curve. 
However, the Q.brixx module requires the information of which 
reference temperature (cold point temperature) is being used.
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7 International Sales and 
Service

The current addresses of our sales partners can be found in the 
Internet on our web site. You can take up direct contact with 
Gantner Instruments GmbH at any time.

You will find further information in the section Technical Infor-
mation in our Wiki at https://dev.gantner-instruments.com/doku-
wiki. The user name is support and the password is gins (not all 
sections are open to the public).
 

Austria Gantner Instruments GmbH

Montafonerstr. 4

6780 Schruns/Austria

Tel.: +43 (0) 55 56 774 63-0
Fax: +43 (0) 55 56 774 63-300

E-mail: office@gantner-instruments.com
Web: www.gantner-instruments.com

Germany Gantner Instruments Test & Measurement GmbH

Heidelberger Landstr. 74

64297 Darmstadt

Tel.: +49 (0) 6151 95136-0
Fax: +49 (0) 6151 95136-26

E-mail: testing@gantner-instruments.com
Web: www.gantner-instruments.com
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